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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2004 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This document is protected under copyright law. An authorized licensee of Avid ISIS 7000 may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document 
is supplied as a guide for Avid ISIS 7000. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without 
notice.

Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

http://www.apache.org/
http://jcifs.samba.org/
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Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Apple, Macintosh, and Safari are either registered trademarks or trademarks of Apple Computer, Inc., registered in the U.S. and 
other countries. HP is a registered trademark of Hewlett-Packard Company. Intel is a registered trademark of Intel Corporation. Java 
is a trademark of Sun Microsystems in the United States and/or other countries. Kingston is a registered trademarks of Kingston 
Technology Corporation. All other marks may be the property of their respective titleholders. Windows is either a registered 
trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein 
are the property of their respective owners. 
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Using This Guide

The Avid® ISIS® media network provides a high-performance distributed file system that 
contains high-capacity shared media storage for workgroups of connected Avid editing 
workstations. This user’s guide describes how to connect your client system to the media 
network, mount workspaces, and configure your system for best performance.

Unless noted otherwise, the material in this document applies to the Windows®, Mac OS® X, and 
Linux operating systems.The majority of screen shots in this document were captured on a 
Windows system, but the information applies to both Windows and Mac OS X systems. Where 
differences exist, both Windows and Mac OS X screen shots are shown.

n The documentation describes the features and hardware of all models. Therefore, your system 
might not contain certain features and hardware that are covered in the documentation.

Who Should Use This Guide

This user’s guide is intended for users who need to access workspaces on the Avid ISIS media 
network. You should have a basic understanding of how to use and manage the Windows 
operating system or the Mac OS X systems, and you should be familiar with basic workgroup 
and network concepts.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to your 
computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. Follow 
the guidelines in this document or on the unit itself when handling electrical 
equipment.
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published.

New information would be found in the ReadMe file supplied on your Avid software 
installation kit as a PDF document and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online versions, visit the Knowledge Base at www.avid.com/US/support.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/US/support. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to 
read or join online message-board discussions.

> This symbol indicates menu commands (and subcommands) in the order you 
select them. For example, File > Import means to open the File menu and 
then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Macintosh), 
or (Linux)

This text indicates that the information applies only to the specified 
operating system, either Windows Macintosh OS X or Linux.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/US/support
http://www.avid.com/US/support
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Accessing the Online Documentation

The Avid ISIS online documentation contains all the product documentation in PDF format. You 
can access the documentation in the AvidISISDocumentation folder on the Avid ISIS installer 
kit. You need to download and install Acrobat Reader on your Avid ISIS before you can access 
the PDF documentation.

n You need to download and install Acrobat Reader on your Avid ISIS before you can access the 
PDF documentation.

To access the online documentation from the installer kit:

1. Insert your Avid ISIS USB flash drive with the Avid ISIS software kit into the USB port.

2. Navigate to the [USB flash drive]:\.AvidISISDocumentation folder, and double-click the 
PDF file for the document you want to view.

Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

http://www.avid.com/support


1 Avid ISIS Client Manager Setup and 
Installation

The following sections provide general information about your Avid ISIS system when you are 
configuring a client system:

• Intel Pro/1000 Network Adapter and Driver Installation

• Dual Port Network Connections

• Myricom 10-Gb Network Adapter and Driver

• Client Software Installation

• Configuring Network Profiles and Firewalls

• Configuring the Client Network Properties

Most Windows® editing clients require the 1-Gb Intel® Pro 1000 PT or PF Ethernet network 
adapter to connect to the Avid ISIS system, even if the clients are connected to an external 
switch. For the most up to date list of Windows computers that require the Intel Pro 1000 
Ethernet network adapter, see the Avid ISIS ReadMe. Macintosh clients and some Windows 
clients have been qualified to use the onboard 1-Gb ports. Macintosh clients can also use the 
Small Tree® PEG1F or PEG2F optical adapter when using optical switches.

Intel Pro/1000 Network Adapter and Driver 
Installation

The Intel Pro 1000 Ethernet network adapters are recommended for most Windows editing 
systems that connect to the Avid ISIS system. The Intel Pro 1000 PT is a copper interface and the 
Intel Pro 1000 PF is an optical interface. Depending on the Intel network adapter used in your 
system, you must load the appropriate driver from the appropriate folder. The Intel drivers 
qualified in this release are included in the Avid ISIS software installer kit: in the 
\Drivers\ISIS Client\Intel_Pro1000\ folder. Install the latest qualified driver 
(Intel_xx). Check the driver version listed in the Windows Control Panel.

n For the latest supported Ethernet network adapters and driver versions, see the Avid ISIS 
ReadMe that corresponds with your software release.
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Intel Pro/1000 Slot Locations

The following table lists the slot location of the Intel Pro/1000 network adapters for Windows 
client systems qualified with the Avid ISIS. 

HP Z820 Integrated Network Port Not Supported

The integrated 82759LM port is marked with the letters AMT in the HP Z820 Workstation is not 
supported as an ISIS client connection. The other integrated Ethernet port that is not labeled is 
qualified for an ISIS client a connection. To use a dual 1 Gb connection with the HP Z820 
Workstation, you must install an Intel Pro 1000 PT or PF for the second port.

HP Z400 and HP Z800 Integrated Network Port Not Supported

The integrated Broadcom BCM5764 gigabit Ethernet controller in HP Z400 and HP Z800 
Workstation is not supported as an ISIS client connection. The HP Z400 and HP Z800 require 
the installation of the Intel Pro 1000 PT or PF. 

Loading or Updating the Intel Pro Driver on Windows Clients

To load the Intel Pro driver on a Windows client:

1. After you install the Intel Pro 1000 network adapter and restart your system, you might 
receive a Hardware Wizard message about looking for the Intel Pro 1000 driver. Cancel the 
message.

2. Copy the file titled Intel_xx.x driver to your client system; found on the Avid ISIS 
software kit in the \Drivers\ISIS Client\Intel_Pro1000\ folder.

3. Double-click the .exe file to expand the compressed file and run the installer.

4. Accept the default settings to install the driver.

n The default Intel transmit and receive descriptors are set to 256 however, when loading the Avid 
ISIS client software the transmit and receive descriptors are set to 1024. For more information, 
see “Intel Pro Driver Configuration Settings” on page 14.

5. Continue with setting the IP address, see “Configuring the Client Network Properties” on 
page 37.

Platform Intel Pro/1000 Network Adapter Slot

HP Z800, Z420 4

HP Z400, Z820 3
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Intel Pro Driver Configuration Settings

You do not need to select the following settings, these setting are provided for reference. The 
Receive and Transmit buffers are set when you install the Avid ISIS Client software, the Flow 
Control and Interrupt settings are the Intel defaults. 

To access the network port properties:

1. Click Start and type devmgmt.msc in the Search text box.

If using Windows 8, you can get to the Search text box by pressing the Windows key on your 
keyboard and start typing on the Windows 8 desktop.

The Device Manager dialog window opens.

2. Double-click the Network adapters category to expand the list.

3. Right-click the first Pro 1000 network port and select Properties.

4. In the Properties dialog box select Internet Protocol Version 4 (TCP/IPv4) and click 
Configure.

5. If ask to confirm any changes, click Yes.

6. Click the Advanced tab.

Intel Pro/1000 Client Network Port Settings  

Option Setting

Flow Control Enabled

Interrupt Moderation Enabled

Interrupt Throttling Rate Adaptive

Receive Buffers 1024

Transmit Buffers 1024
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7. Click the Performance Options in the Setting list.

8. Click Properties.

9. Click Flow Control and set the Value to Rx&Tx Enabled. 

10. Click Interrupt Moderation Rate and set the Value to Enabled.

11. Click Interrupt Throttling Rate and set the Value to Adaptive.

12. Check that the Receive Buffers Value is set to 1024. 

13. Check that the Transmit Buffers Value is set to 1024. 

14. Click OK to close the Performance Options.

15. Click the Power Management tab.
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16. Deselect the “Reduce power if cable disconnected” power saving option.

17. Deselect the “Reduce link speed during standby” power saving option.

18. Click OK to close the Server Adapter Properties dialog box.

19. (Option) If this is a dual port network adapter, repeat steps 3 through 18 to configure the 
second Intel Pro 1000 port.

20. Restart the client system.

Dual Port Network Connections
Dual 1-Gb Ethernet connections allow you to use a dual-attached client for redundancy and 
performance enhancements. The dual port Intel Pro network adapter is supported with Windows 
clients and the built-in dual Ethernet ports are supported with Macintosh clients. Each port is 
configured separately. When using a dual port configuration, check that both ports are enabled in 
the ISIS Client Manager Network Interface Settings and the network properties (see “Network 
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Interface Setting” on page 60 and “Configuring the Client Network Properties” on page 37). 
Dual connected ISIS 2000 and ISIS 5500 | 5000 clients must be on the same subnet, ISIS 7500 | 
7000 clients can connect to the same subnet or to both VLANs for redundancy. The dual 1 GB 
connections can be connected to the same ISIS qualified switch. If you have access to both an 
ISIS 5500 | 5000 and an ISIS 7500 | 7000, one port can be connected to each infrastructure. Dual 
10 GB client connections are not supported.

Myricom 10-Gb Network Adapter and Driver
The Myricom® 10-Gb Ethernet adapter is qualified on Windows, Macintosh, and Linux 
operating systems for Avid editing ultra high resolution clients (UHRC). These 10-Gb clients 
connect directly into the ISIS Engine in a direct connect configuration or to the 10-Gb port of the 
switch.

If your client cannot connect directly to an Avid ISIS Engine, Avid has qualified several switches 
that provide 10-Gb connections. For information on qualified switches, see the Avid ISIS 
ReadMe.

n The Myricom 10-Gb Ethernet driver is automatically installed on Linux clients when Linux 
clients install the ISIS Client software.

The Myricom network adapter has been qualified in the following configurations:

• Slot 2 in the Macintosh Pro Nehalem and Westmere 2.66 GHz and 2.93 GHz 

• Slot 3in the HP Z820 

• Slot 4 in the HP Z800 

• Slot 4 in the HP Z420 

• Slot 4 in the HP Z400 (local storage is not supported when the Myricom network adapter is 
installed)

Once your Avid ISIS 10-Gb client hardware and software is installed, you need to use the Ultra 
High Resolution setting in the Client Manager Preferences with Avid editing clients.

Installing the Myricom Network Adapter on Windows Clients

The Myricom driver v1.1.10 or later is required for 10 Gb Windows clients. Copy the installer to 
your Avid editing client and use the following information to setup and Myricom 10-Gb network 
adapter. The Myricom driver can be found in the \Drivers\ISIS Client\Myricom\ folder of 
the ISIS software kit. 
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n The driver installer functions the same regardless if you installing the Myricom driver for the 
first time or upgrading an existing Myricom driver. If you are upgrading your Myricom driver 
start with step 3.

To install the Myricom network adapter and driver in Windows clients:

1. Shutdown the Avid editing system.

2. Install Myricom network adapter in the slot and system that has been qualified:

- Slot 3 in the HP Z820

- Slot 4 in the HP Z400, Z420, and Z800

For slot information, search the Avid Knowledge Base for System Configuration Guidelines 
and Slot Configurations.

3. Copy the Myricom driver from the Avid ISIS software kit to the Windows 10 Gb 64-bit 
client. 

The Myricom driver can be found in the \Drivers\ISIS Client\Myricom\ folder.

4. Double-click the myrige-x.x.x.msi installer and follow the on screen instructions, 
accepting the defaults settings.

The installer functions the same regardless if you installing the Myricom driver for the first 
time or upgrading an existing Myricom driver.

5. Install Avid ISIS client software.

6. Restart the client after the installation is complete.

7. Start the Avid ISIS client software and select the following UHRC requirements.

- Select the Ultra High Resolution setting in the Client Manager Preferences.

- Mount a workspace.

Myricom Network Adapter Setting on Windows Clients

When installing the Client software, the Myricom driver settings are automatically set for you. 
This section provides the required Myricom 10-Gb network adapter settings as a reference. 

To configure the Myricom network adapter in Windows clients:

1. Click Start and type ncpa.cpl in the Search text box.

If using Windows 8, you can get to the Search text box by pressing the Windows key on your 
keyboard and start typing on the Windows 8 desktop.

http://avid.force.com/pkb/articles/en_US/user_guide/en269631?popup=true&NewLang=en&DocType=1082
http://avid.force.com/pkb/articles/en_US/user_guide/en269631?popup=true&NewLang=en&DocType=1082
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2. Right-click on the Myricom adapter and select Properties.

3. Click Configure. 
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4. Click the Advanced tab.
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5. The following are the Avid ISIS Window’s client settings.

6. Click Ok. 

After changing the Myricom driver settings, restart your client system.

Myricom 10 Gb Network Settings  

Option Setting

Flow Control On

Interrupt Coalescing Delay 2

Receive Buffers 2048

MTU 1500

Receive Side Scaling (RSS) Disabled
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Installing the Myricom Network Adapter on Macintosh Clients

The Avid ISIS software is available on the Avid ISIS Software kit. Load the files on your Avid 
editing client and use the following information to setup the Myricom 10-Gb network adapter. 

To install the Myricom network adapter in Macintosh clients:

1. Shutdown the Avid editing system.

2. Install the Myricom network adapter in slot 2 of a Macintosh Pro Nehalem system 
(2.66 GHz or 2.93 GHz). For slot information, search the Avid Knowledge Base for System 
Configuration Guidelines and Slot Configurations.

3. Double-click the Myri10GE-xx.dmg file to mount the file.

The file (myri10ge-macosx-xx.dmg) can be found on the Avid ISIS software kit in the 
Drivers/ISIS Client/Myricom/ folder.

4. Double-click the Myri10GE-xx.mpkg file to run the installer package.

Follow the on-screen instructions.

5. Install Myricom driver following the default prompts.

6. Set the “Myricom Network Adapter Setting on Macintosh Clients” on page 22.

7. Install Avid ISIS client software.

8. Restart the client finish the installation.

9. Start the Avid ISIS client software and select the following UHRC requirements.

- Select the Ultra High Resolution setting in the Client Manager Preferences.

- Mount a 512 KB chunk size workspace.

Myricom Network Adapter Setting on Macintosh Clients

The Myricom 10-Gb network adapter requires the following settings. 

http://avid.force.com/pkb/articles/en_US/user_guide/en269631?popup=true&NewLang=en&DocType=1082
http://avid.force.com/pkb/articles/en_US/user_guide/en269631?popup=true&NewLang=en&DocType=1082
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To configure the Myricom network adapter in Macintosh clients:

1. On your Macintosh 10-Gb client, click Apple > System Preferences.

2. In the Internet & Wireless section, click Network.

3. In the left pane, select the Myricom entry and click Advanced.
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4. Click the Ethernet tab (depending on your Mac OS, this selection could be the Hardware 
tab).
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5. Select the following settings.

6. Click Ok. 

After changing the Myricom driver settings, restart your client system.

Updating the Myricom Driver on Macintosh Clients

The Myricom driver v1.3 or later is required for 10 Gb Macintosh clients with Mac OS v10.7.x 
and v10.8.x. Previous versions of the Myricom driver do not work. 

Myricom 10 Gb Network Settings  

Option Setting

Configure Manually

Speed Autoselect

Duplex Full - Duplex, Flow-Control

MTU Standard (1500)



Client Software Installation

26

To install the Myricom driver on Macintosh clients:

1. Copy the Myri10GE-xx.dmg file from the Avid ISIS software installer kit to your 10 Gb 
Macintosh client. The file is located in the following location: 
Tools_3rdParty\Drivers_and_Firmware\Myricom\Mac\ folder.

2. Double-click the Myri10GE-xx.dmg file to mount the file.

3. Double-click the installer package to run the installer.

4. Install Myricom driver following the default prompts.

5. Continue with “Myricom Network Adapter Setting on Macintosh Clients” on page 22.

When you start the Avid ISIS client software remember to and select the following UHRC 
requirements.

- Select the Ultra High Resolution setting in the Client Manager Preferences.

- Mount a 512 KB chunk size workspace.

Client Software Installation
This section contains information about installing or upgrading the client software on your 
system. A user account with Administrator privileges is required to install Avid ISIS client 
software on your workstations.

Fast User Switching Not Supported

Fast User Switching is a Windows feature that allows multiple user accounts to log on to a 
computer simultaneously. Fast User Switching is enabled by default in Windows computers. The 
Fast User Switching feature and multiple concurrent logged on user modes are not supported in 
the Avid ISIS environment. The ISIS software does not distinguish the different drive letters 
mapped to the same workspaces on the same computer. Conflicts appear in the following two 
scenarios:

• When one user maps a drive letter to one workspace and another user maps the same drive 
letter to a different workspace

•  When one user maps a workspace to one drive letter, and another user maps a different drive 
letter for the same workspace.



Client Software Installation

27

Flash Player Software

To use the ISIS Management Console, you need to have the Adobe® Flash® Player (v11.x or 
later) installed on your system. If you encounter problems with the ISIS Management Console 
display, you might have an outdated version or multiple versions of the Flash Player installed. 
Uninstall any previous versions of Flash Player and install the Flash Player included on the Avid 
ISIS software installer kit. Avid ISIS requires Flash Player v11.x and later.

Loading Client Software

You are now ready to load your Avid ISIS client software on the supported Macintosh or 
Windows clients. You can load the Client software in the following ways:

• You can use a Browser to reach the ISIS Management Console and load it from the System 
Director.

• Download the client installers from the Management Console and copy the software to a 
USB flash drive.

• You can store the client software somewhere on the network and allow everyone who needs 
the software to gain access to it and load it.

• The ISIS installer splash screen includes a Windows client software installer. Selecting the 
“ISIS Windows Client” software package from the splash screen and clicking Apply, 
uninstalls the earlier version of the software without having to use the Windows Control 
Panel and installs the new software with a single click. 

When installing Avid ISIS client software on Windows systems, make sure you are up-to-date 
with your Windows critical updates.

To install the client software using a browser:

1. Start your browser application.

2. Run your Windows Update and accept all “High-priority Updates.”

3. Depending on your ISIS system, type the following in your browser.

t ISIS 5500 — http://IP address of System Director 

t ISIS 7500 and ISIS 2000 — https://IP address of System Director:5015

n If your Avid ISIS network includes a Domain Name System (DNS), you can type the System 
Director’s name in the browser (default Virtual name is AvidISIS).

The ISIS Management Console opens. 

4. Type your ISIS user name and password.

5. Click the Installers icon.
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An Installer Downloads screen opens.

6. Click the appropriate client installer.

t Windows *.msi

t Macintosh *.dmg

t Linux *.bin

The installer might ask if you want to save or run the installation software; either is 
acceptable.

7. Restart the client if prompted.

The client software starts automatically when restarted. 

ISIS Client Software Installation

The following are procedures for installing the client software. Besides the Windows *.msi file 
available in the Installers page of the Management Console, Windows clients can install the ISIS 
Client software using the software kit splash screen. 

To install your Avid ISIS Windows client software from the software kit:

1. Log into your Windows client system as a user with Administrative privileges.

2. Load the new software kit on your Windows client system.
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3. Double-click the Autorun.exe file in the software kit.

The installer detects the existing version of the installed client software (if any) and displays 
the components that need to be upgraded in the splash screen. 

4. Select the “ISIS Windows Client” installer from the Select Software Package menu.

5. Click Apply.

n The installer automatically uninstalls an earlier version of software.

6. Update the Intel Pro driver on your client system, see “Loading or Updating the Intel Pro 
Driver on Windows Clients” on page 13.

7. Repeat this procedure on each Avid ISIS Windows client.

n You can manually copy the client installers to a USB flash drive. The installers are in the Avid 
ISIS software kit located on [drive]:\AvidISISClientInstallers. You can also log into the 
Management Console and access the Installers link and download the appropriate client 
installer.

To install your Avid ISIS Macintosh client software:

1. Copy and save the new AvidISISClient_MacOSX_x.x.x.dmg file from the:

t \AvidISISClientInstallers folder in software kit to your Macintosh client system.

t Management Console > Installer page to your Macintosh client system. 

2. Double-click the AvidISISClient_MacOSX_x.x.x.dmg file. 

3. Double-click the AvidISISClient.mpkg file to run the installer.

Follow the on-screen instructions.

n The installer replaces earlier versions of the software (if any).

4. Repeat this procedure on each Avid ISIS Macintosh client.

n You can manually copy the client installers to a USB flash drive. 

c The Macintosh client software installs an uninstaller application located at Applications 
> Avid_Uninstallers > AvidISIS. Use this application only when you want all Avid 
client files removed; including Client Manager preferences.

To install ISIS Linux client software:

1. Copy and save the new AvidISISClient_el6.x86_x.x.x.bin file from the:

t \AvidISISClientInstallers folder in software kit to the user’s home directory of 
your Linux client system.
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t Management Console > Installer page to the user's home directory of your Linux client 
system. 

2. Open the Terminal application: Application > System Tools > Terminal on your 
Linux client.

n When using the Terminal program, file names and paths are case sensitive.

3. Type cd [user’s home directory] and press Enter.

4. Type chmod +x AvidISISClient_el6.x86_x.x.x.bin and press Enter.

5. Do one of the following.

t If you are not the root user, type sudo ./AvidISISClient_el6.x86_x.x.x.bin and 
press Enter. You will need to enter your password.

t If you are the root user, type ./AvidISISClient_el6.x86_x.x.x.bin and press 
Enter.

n The installer replaces earlier versions of the software (if any).

n You can manually copy the client installers to a USB flash drive. 

6. Restart the Linux client.

To uninstall Linux ISIS client software (and all of the dependencies):

t Open the Terminal application and type sudo /usr/sbin/avid-isis-uninstaller. 

n Do not uninstall ISIS Client Manager using the System > Administration > Add/Remove 
Program feature. This function does not completely remove all the ISIS Client Manager software. 

Configuring Client Software

To mount workspaces on the client do the following:

1. Load the client software as explained in “Loading Client Software” on page 27.

2. Do one of the following:

t (Windows) If the Client Manager icon is not available in the Windows taskbar, select 
Start > Programs > Avid > ISIS Client > ISISClientManager.

t (Windows) Click the Client Manager icon in the Windows taskbar.

t (Windows) Right-click the Client Manager icon and select Avid ISIS Client Manager.

t (Macintosh) Select Go > Applications, and then double-click the AvidISIS folder. In 
this folder, double-click the ISISClientManager.app file.

t (Linux) Click Applications > System Tools and select Avid ISIS Client Manager.
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n To add the Client Manager launcher icon to the panel or desktop when using a Linux client, click 
Applications > System Tools and right-click Avid ISIS Client Manager and select add launcher to 
panel or desktop.

The ISIS Client Manager opens.

3. (Option) If your ISIS client is not directly connected to the Engine or to the primary switch, 
you need to select the Remote Host (Avid ISIS system) the first time you login. For 
information adding your remote host see “Adding a Remote Host” on page 56. 

n The Client Manager user interface could take up to 30 seconds to display changes made in the 
Remote Host Settings. 

4. Select the ISIS system in the Systems panel.

5. Click the Connect button in the Systems panel.

6. Login using the Username and Password assigned to you by the Avid ISIS administrator. Do 
one of the following:

t (Windows) Type your account name in the Username text box, and type your password 
in the Password text box.
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t (Windows) If your ISIS system is configured to use the Windows user name and 
password for your local system, select OS Login. By default, the Username and 
Password text boxes are inactive when you select this option.

(Optional — Windows only) If you used the OS Login option, and you want to connect 
to the network automatically every time you start your system, select the Auto-Connect 
checkbox.

t (Macintosh) Type your Avid ISIS account name in the Username text box, and type your 
password in the Password text box.

t (Linux) Type your Avid ISIS account name in the Username text box, and type your 
password in the Password text box.

When the connection is successful, workspaces you have been given access to are listed in 
the Workspaces list.

Macintosh Mountain Lion Operating System

Avid recommends a clean install of Macintosh Mountain Lion OS X v10.8.x but a Mac OS 
upgrade to your existing Lion system is supported. Mountain Lion clients require ISIS v4.2 and 
later client software.

n To use the ISIS Management Console, you need to have Adobe Flash Player installed on your 
system. Macintosh operating systems require the latest versions of Flash Player installed. You 
can download the Flash Player at http://www.adobe.com.

To install ISIS client software on your Macintosh Lion system:

1. Remove the old version of the ISIS client software using the uninstaller in the Applications 
> Avid_Uninstallers folder.

2. Perform a clean install, or upgrade to Macintosh Lion (see your Macintosh documentation).

3. Install ISIS client software.

10 Gb Myricom Board Driver Macintosh v10.8.x Clients

The Avid ISIS software kit includes the 10 Gb Myricom driver for Ethernet Macintosh v10.8.x 
clients. The Myricom driver qualified in this release is included in the Avid ISIS software kit 
(\Drivers\ISIS Client\Myricom\myri10ge-macosx-1.3.3avid-1500.dmg).

Instructions for installing the 10-Gb adapter boards and installing the software are provided in 
the “Installing the Myricom Network Adapter on Macintosh Clients” on page 22. Once the 
Myricom 10-Gb adapter board is installed, upgrade the driver. 

http://www.adobe.com/downloads/
http://www.adobe.com/downloads/
http://www.adobe.com/downloads/
http://www.adobe.com
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Updating Client Manager Software

Before updating the Avid ISIS Client Manager software on your system, you must unmount any 
mounted workspaces and exit the Client Manager software.

n To get started with the client upgrades, you can manually copy the client installers to a USB 
flash drive. The installers on the System Director are located on 
[drive]:\AvidISISClientInstallers. You can also log into the Management Console and access the 
Installers link and download the appropriate client installer.

• For Windows clients, you need to uninstall the ISIS client using Windows Control Panel, 
install ISIS client, and restart. 

The ISIS installer splash screen includes a Windows client software installer. Selecting the 
“ISIS Windows Client” software package from the splash screen and clicking Apply, 
uninstalls the earlier version of the software without having to use the Windows Control 
Panel and installs the new software with a single click. 

• For Linux clients, installing the new client software updates the previous version. 
Preferences are saved and you do not need to restart the client.

• For Macintosh clients, installing the new client software updates the previous version. 
Preferences are saved and you do not need to restart the client.

If you use the Safari browser to install the Avid ISIS software on a Macintosh client, note 
that the disk image is mounted as soon as the download is complete, and the installer starts 
automatically. Other browser applications do not automatically mount the disk image.

c The Macintosh client software installs an Avid_Uninstall folder. Use this folder only when 
you want all of the Avid client files removed; including the preference files.

After the software is successfully installed on your client, dismount the installer volume:

To dismount the Avid ISIS installer volume on a Macintosh client:

1. Locate the mounted volumes listed in the left pane of the Finder window.

2. Select the volume that contains “AvidISIS” in the name.

3.  Do one of the following:

t Right-click the volume and select eject.

t Drag the volume to the Trash in the dock and it will eject.
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Client Licensing

Any client that connects to the Avid ISIS system is included in the Avid ISIS client count stored 
in the System Director License key. There is no need to order special licenses for each client. If 
you are not certain about your license status, see the Avid ISIS ReadMe for number of supported 
clients or your ISIS system administrator.

Configuring Network Profiles and Firewalls

When enabled, some Firewall settings on Avid ISIS clients prevent you from connecting to the 
Avid ISIS environment. The following sections describe where the network profiles settings are 
located in the Client Manager software.

n If you are not sure which Firewall profile to use with Windows clients, enable all three Profiles 
under Windows Firewall settings. This insures that the ISIS clients work in all Firewall 
configurations. 

Configuring Windows 8, Windows 7, and Windows Vista Network Profiles

Network profiles are used by Windows Vista to distinguish between Public, Private, and Domain 
network connections. Because each network profile uses its own security settings, you must 
configure the Client Manager settings so that the appropriate ports are opened for each 
applicable network profile on your system.

n You only need to configure Client Manager settings for the network profiles that are connected to 
your ISIS system. If you are unsure which network connections are used with your ISIS system, 
see your network administrator.

To configure the Client Manager settings for Windows Vista network profiles:

1. Verify which network connection profile(s) are used to connect to your ISIS system by doing 
the following:

a. Click Start > Control Panel.

The Windows Control Panel opens.

b. Click “Network and Internet.”

The Network and Internet window opens.

c. Click “Network and Sharing Center.”

The Network and Sharing Center window opens.

The Network and Sharing Center window lists the network connections present on your 
system and which network profile has been applied to them. The three possible network 
profiles are the following:
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- Domain network

- Public network

- Private network

Once you have determined which network profile has been applied to the connection(s) to 
your ISIS system, you can go to the next step.

2. Open the Client Manager. (For information on opening the Client Manager, see “ISIS 
Shared Storage Network Connection” on page 51.)

3. Click the General Preferences button in the Client Manager window.

The General Preferences dialog box opens.

n Windows XP and Windows Storage Server 2003 clients do not have a Windows Firewall section 
in the General Preferences window.

4. In the Profiles section, click the checkbox next to each applicable network profile type to 
enable firewall configuration.

n You only need to enable firewall configuration for the network profiles that are connected to your 
ISIS system.
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5. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

6. (Windows Vista clients) Restart your Windows Vista system for the firewall configuration to 
take effect.

Configuring the Windows XP Firewall

The Windows XP Firewall is set by default. The Windows Firewall is part of the Security Center 
located in the Windows XP Control Panel. The Client Manager installer will automatically 
configure the Windows Firewall to open the correct ports, but it is possible to have errors if the 
“Don’t allow Exceptions” option is selected on the General tab of the Windows Firewall dialog 
box. 

To make sure that the settings are correct when the firewall is enabled:

1. From the Windows Control Panel, open Security Center.

The Windows Security Center window opens.

2. Click Windows Firewall.

The Windows Firewall dialog box opens. 

3. Click the General tab, and select On (recommended). You can select Off (not recommended) 
if you do not want to enable the firewall.

4. Deselect “Don’t allow exceptions.”

5. Click OK.

Macintosh Support and Firewall

You can use any of the onboard Ethernet ports on the Macintosh system to connect to the media 
network. For a list of supported Macintosh systems, see the Avid ISIS ReadMe.

n See the documentation provided with your Macintosh system for the exact location of the 
Ethernet port.

Some Firewall settings on Macintosh clients prevent you from connecting to the Avid ISIS 
environment when enabled. You might receive an error message informing you that no System 
Directors were found and that the problem might be the Firewall settings.

Linux Firewall

The Linux client installer configures the Linux Firewall settings for communication between the 
Linux clients and the System Director in the Avid ISIS environment. 
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Configuring the Client Network Properties
Before you can connect your clients to the Avid ISIS network, you must configure the network 
properties on each client. If using the default Avid ISIS 5500 | 5000 setup, you need to set a static 
IP address and subnet mask for the Ethernet port connection on every client. 

n If your Avid ISIS network includes a DHCP server, clients can automatically obtain 
IP addresses. You only need to assign static IP addresses on your Ethernet clients if you do not 
have a DHCP server.

Windows 8, Windows 7, and Windows Vista Client Network Properties

To configure the Ethernet port on your Windows Vista, Windows 7, or Windows 8 clients:

1. Click Start and type ncpa.cpl in the Search text box.

If using Windows 8, you can get to the Search text box by pressing the Windows key on your 
keyboard and start typing on the Windows 8 desktop.

2. Right-click the Local Area Connection and select Properties.
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3. Select the Internet Protocol Version 4 (TCP/IP) option.

4. Click the Properties button. The Internet Protocol Version 4 (TCP/IP) Properties dialog box 
opens.

5. In the General tab, select the “Use the following IP address” option.

6. Type a unique IP address in the IP address text box. Depending on your configuration.

t Direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.

t Switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.

7. Type the appropriate subnet mask in the Subnet mask text box.

8. (Optional) If connecting to a corporate network or outside the ISIS subnet, you need to add 
the Default gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.

9. Click OK to close each of the open dialog boxes and save the changes.
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Windows XP Client Network Properties

To configure the Ethernet port on your Windows XP clients:

1. Right-click the Network icon on the desktop, and select Properties. The Network and 
Sharing Center window opens.

2. Right-click the Local Area Connection and select Properties.

3. Select the Internet Protocol (TCP/IP) option.

4. Click the Properties button. The Internet Protocol (TCP/IP) Properties dialog box opens.

5. In the General tab, select the “Use the following IP address” option.

6. Type a unique IP address in the IP address text box. Depending on your configuration.

t Direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.

t Switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.

7. Type the appropriate subnet mask in the Subnet mask text box.
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8. (Optional) If connecting to a corporate network or outside the ISIS subnet, you need to add 
the Default gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.

9. Click OK to close each of the open dialog boxes and save the changes.

10. Close all the remaining open windows and dialog boxes.

Macintosh Client Network Properties

To configure the Ethernet port on your Macintosh clients:

1. Click System Preferences in the Dock. 

2. Click Network.

3. Select the Ethernet port in the left pane.

4. In the right pane select Manually from the Configure IPv4 menu.

5. Type a unique IP address in the IP Address text box. Depending on your configuration.

t Direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.
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t Switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.

6. Type the appropriate subnet mask in the Subnet Mask text box.

7. (Optional) If connecting to a corporate network or outside the ISIS subnet, you need to add 
the Default gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.

8. (Option) If this is a dual port configuration, repeat steps 3 through 7 to configure the second 
Intel Pro 1000 port.

9. Click Apply. 

Linux Client Network Properties

To configure the Ethernet port on your Linux clients:

1. Click System > Preferences > Network Connections. 

2. Click the Wired tab (selected by default).

3. Select the network connection and click Edit.
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4. Click the IPv4 Setting tab. 

5. Select Manual from the Method menu.

6. Click Add. 

7. Type a unique IP address in the Address text box. Depending on your configuration.

t Direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.

t Switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS 
administrator.

8. Type the appropriate subnet mask in the Netmask text box.

9. (Optional) If connecting to a corporate network or outside the ISIS subnet, you need to add 
the default gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.
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10. (Option) If this is a dual port configuration, repeat steps 3 through 7 to configure the second 
Intel Pro 1000 port.

11. Click Apply. 

10 Gb Network Connections

The 10 Gb network adapter can connect directly into the 10 Gb port on the Avid ISIS 5500 | 5000 
Engine or the 10 Gb port on the switch. On Avid ISIS 7500 | 7000 Engines with two ISS 
switches installed, two Avid ISIS clients with 10 Gb network adapters can be connected (one to 
each ISS) or the 10 Gb port on the switch. Clients with 10 Gb network adapters access to the 
Avid ISIS 2000 through a 10 Gb port on a switch. Only proxy resolutions are supported for 
smooth playback regardless of the client network connection when accessing ISIS 2000 
workspaces. 

If your client cannot connect directly to an Avid ISIS Engine, Avid has qualified several switches 
that provide 10 Gb connections. For information on qualified switches, see the Avid ISIS 
ReadMe.

n For information on configuring the ISIS switches, see the Avid Network and Switch Guide in the 
documentation folder of the Avid ISIS software kit [drive]:\AvidISISDocumentation. 

Configure 10 Gb Client Connection 

Some client configurations might require that the 10 Gb network adapter is the only active 
network interface available to ISIS. If this is the case, you need to disable the other network 
interfaces in the Client Manager network preferences.

n Disabling a network card in the Client Manager Preferences only makes the card unavailable to 
Avid ISIS. It does not affect the card’s functionality in the operating system or any other 
applications.

To ensure that the 10 Gb connection is the primary connection:

1. Start the Client Manager application.

2. Click the Network Interface Settings button from the toolbar of the Client Manager window.

3. Verify that the 10-Gb network adapter appears in the network interfaces list and that Enabled 
is selected.

The Network Interfaces dialog box opens.
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4. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

10-Gb Client Resolution Settings

The Avid ISIS editing client with a 10-Gb network adapter installed should use the Ultra High 
Resolution setting in the Client Manager Preferences. 

n If using the 10-Gb network adapter in an Avid Interplay server for the Copy/Move Service, use 
the Medium Resolution setting in the Client Manager Preferences.

To select the for the resolution preference:

1. Click the General Preference Settings button from the toolbar of the Client Manager 
window.

The General Preferences dialog box opens.
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2. In the Client Type drop down, select “Ultra High Resolution.”

3. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.



2 Using Avid ISIS Client Manager

This section contains the following topics:

• Client Manager Window

• Client Manager Buttons

• ISIS Shared Storage Network Connection

• ISIS Connection Tests

• Mounting and Unmounting Workspaces

• Workspace Display

• Bandwidth Reservations

• Administrative Tasks

Avid ISIS Client Manager allows your client to connect to the Avid ISIS shared storage network. 
When you install the Avid ISIS Client, the Client Manager runs in the background so you can 
mount and access your workspaces at any time, as well as manage your workspaces and 
bandwidth reservations. On Windows clients an icon appears in the System Tray in the lower 
right corner of your desktop. On Macintosh clients, an icon appears in the dock. When you open 
the application and login, the Client Manager displays all available System Directors and all 
available workspaces.

The Client Manager allows users with the necessary account privileges to specify client 
bandwidth reservations, if any.

Client Manager Window
The following illustration describes the sections of the Client Manager window.
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1 Client Manager Tool bar — change preferences or access help

2 Systems list — lists all available and connected ISIS systems: ISIS 5500 | 5000 and ISIS 7500 | 7000 
systems have a System Type of “Online,” ISIS 2000 is listed as “Nearline” 

3 System bandwidth area — bandwidth settings (hidden by default), display setting is in the General 
Preference Setting dialog window

4 Workspaces list — lists all workspaces available on connected ISIS systems

5 Workspaces details area — retrieves details about all available and/or mounted workspaces in the 
workspaces list

6 Messages area — Log of information, warnings and error messages
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Client Manager Buttons
The following table describes the Client Manager buttons. You can also hold the cursor over the 
button and get a tool tip on the button function.

Button Location Function

Client Manager 
window toolbar 

Toggles the “Systems” pane in the Client Manager window to 
display or be hidden

Client Manager 
window toolbar 

Toggles the “Logs” pane in the Client Manager window to display or 
be hidden

Client Manager 
window toolbar 

Opens the General Preference Settings dialog box

Client Manager 
window toolbar 

Opens the Remote Hosts Settings dialog box

Client Manager 
window toolbar

Opens the Network Interfaces Settings dialog

Client Manager 
window toolbar 

Opens the Advanced Settings dialog
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English Client Manager 
window toolbar 

Selects the country language displayed in the Client Manager 
window. The following languages are available.

• Arabic

• English 

• French

• German

• Italian

• Japanese

• Korean

• Russian

• Simplified Chinese

• Spanish

Client Manager 
window toolbar 

 Opens the Client Manager Help. Help is available in the language 
matching the language displayed.

Systems toolbar Connect to the selected ISIS systems

Systems toolbar  Disconnect from the selected ISIS systems

Systems toolbar  Opens the Management Console for the selected systems

Systems toolbar  Change password for the current user

Systems toolbar  Reserve Bandwidth

Systems toolbar  Configure Reserve Rate

Button Location Function (Continued)
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Systems toolbar Toggle Auto Reservation

Systems Login Icon representing a client user

Systems Login Icon representing the client user has OS Login selected

Systems Login Icon representing the client user has Auto Connect selected

Workspaces toolbar  Mount Selected Workspaces

Workspaces toolbar  Unmount Selected Workspaces

Workspaces toolbar Assign Mount Point to Selected Workspace

Workspaces toolbar Toggle Auto Mount Workspaces

Workspaces toolbar  Retrieve Details for the mounted workspaces

Workspaces toolbar Retrieve Details for all workspaces

Button Location Function (Continued)
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ISIS Shared Storage Network Connection
The Client Manager software automatically checks for System Directors on the Avid ISIS shared 
storage network. ISIS 5500 | 5000 and ISIS 7500 | 7000 System Directors display as “Online” in 
the System Type column of the Client Manager, the ISIS 2000 displays as “Nearline.” Once the 
Client Manager software has been configured, the Client Manager can reconnect automatically 
when you restart your system. 

Logs toolbar Saves the messages displayed in the current Client Manager window, 
the default location is:

• (Windows) C:\Program Files\Avid\ISIS Client

• (Macintosh) [Drive]:/Users/USERNAME

Client Manager logs are automatically saved even when the Save 
Log Message button is not clicked. Logs are saved in the following 
location:

• (Windows) C:\Users\USERNAME\AppData\Local\Avid\ISIS
ClientManager\Logs

• (Macintosh) [Drive]:/Users/USERNAME/Library/Application 
Support/Avid/ISISClientManager/Logs

Advance settings and 
common in Client 
Manager windows

Clears the cache saved on the client system in the Advance Settings 
or clears the entry in dialog boxes

Common in Client 
Manager windows 

Adds new entry to the dialog box

Common in Client 
Manager windows 

Deletes the selected entry from the dialog box

Common in Client 
Manager windows 

Applies settings or changes made in the open dialog box

Common in Client 
Manager windows 

Closes the open dialog box. Any changes that were not applied 
reverted back to the last saved settings

Button Location Function (Continued)
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If your system is a Zone 3 or a Zone 4 client, you must add the remote server IP address for your 
System Director. For more information, see “Adding a Remote Host” on page 56.

For information on Avid ISIS zone descriptions, see “Avid ISIS Client and Zone Descriptions” 
on page 55.

Connecting to the ISIS Shared Storage Network

If your system is connected to an Avid ISIS shared storage network, you can use the Client 
Manager to mount a workspace before you begin your work session. 

To connect to the Avid ISIS network:

1. Do one of the following:

t (Windows) If the Client Manager icon is not available in the Windows taskbar, select 
Start > All Programs > Avid > ISIS Client > ISIS Client Manager.

t (Windows) Click the Client Manager icon in the Windows taskbar.

t (Windows) Right-click the Client Manager icon and select Avid ISIS Client Manager.

t (Macintosh) If the Client Manager alias icon is not available, select Go > Applications, 
and then double-click the AvidISIS folder. In this folder, double-click the 
ISISClientManager icon.

t (Linux) If the Client Manager alias icon is not available, click Applications > System 
Tools and select Avid ISIS Client Manager.

2. Select the System Director you want to connect to from the Systems list. 

If this is the first time connecting you need to identify your System Director, see “Adding a 
Remote Host” on page 56.

3. Connect by doing one of the following:

t Click the Connect button.

t Right-click on the System Director name and select Connect.

t Double-click the System Director name.

4. Log-in by doing one of the following:

t (Windows) Type your account name in the Username text box, and type your password 
in the Password text box.

t (Windows) If your ISIS system is configured to use the Windows user name and 
password for your local system, select OS Login. By default, the Username and 
Password text boxes are inactive when you select this option.

t (Macintosh) Type your ISIS account name in the Username text box, and type your 
password in the Password text box.
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t (Linux) Type your ISIS account name in the Username text box, and type your password 
in the Password text box.

5. Click the Connect button.

When the connection is successful, the Change Password and Launch Management Console 
buttons become active.

6. (Option) if you used the OS Login option, and you want to connect to the network 
automatically every time you start your system, select the Auto Connect box.

Client Manager Tray Icon (Windows and Linux)

When the Client Manager is running, an icon appears in the system tray. The tray icon color 
indicates the client connection status:

If you hover the mouse cursor over the tray icon, a tooltip containing additional information 
appears.

Changing Your Password

You can use the Client Manager to change the password you use to log on to your Avid ISIS user 
account.

Icon Status

Client Manager is running, but there are no active ISIS connections.

Client is connected to one or more ISIS systems, but there are no mounted workspaces.

Client is connected to one or more ISIS systems, and there are one or more mounted 
workspaces.

Indicates a connection error.



ISIS Shared Storage Network Connection

54

n If your user name and password are different for your client system and your Avid ISIS account, 
your system cannot automatically reconnect to the media network when you restart your system.

To change your Avid ISIS account password:

1. Open the Client Manager (see “Connecting to the ISIS Shared Storage Network” on 
page 52).

2. Log into the ISIS system for which you want to change your password, if you are not 
already.

3. Click the Change Password button.

The Change Password dialog opens.

4. Type your existing password in the Old Password text box.

5. Type your new password in the New Password text box.

6. For confirmation, type the password again in the Confirm New Password text box.

7. Click the green check mark to apply the changes or click the red X to close the dialog box 
without any changes.

Opening the ISIS Management Console from the Client Manager

You can open the ISIS Management Console from the Client Manager window after you have 
connected to an ISIS system. From the Management Console login screen you can access the 
complete Management Console documentation using the Help link.

To open the ISIS Management Console:

t Click the Open Management Console button from the Systems section of the Client 
Manager window.

Your default web browser opens to the ISIS Management Console login window.



ISIS Shared Storage Network Connection

55

n The ISIS Management Console display might differ according to your user account’s access 
privileges.

Avid ISIS Client and Zone Descriptions

All clients in the media network are classified by zones, depending on how they connect to the 
network. The following list defines the clients in each network layer by its zone classification:

• Zone 1 Client — Connected to ISIS VLANs via an ISIS 7500 | 7000 ISS or ISIS 5500 | 5000 
System Director port (direct connect)

• Zone 2 Client — Connected to ISIS VLANs via an Avid qualified layer-3 switch 
(non-routed)

• Zone 3 Client — Connected to an Avid qualified layer-3 switch (routed) with known Quality 
of Service (QoS); traffic routed to ISIS (one hop) and load-balanced across ISIS VLANs 
(~60/40 ratio)

• Zone 4 Client — Connected to the house network using an edge or a core switch with 
unknown QoS; traffic routed to Avid ISIS (measured by the number of hops) and 
load-balanced across ISIS VLANs (approximately a 60/40 ratio)

n Clients connected in one zone can run in any lower-numbered zone — for example, a Zone 3 
client can also run as a Zone 2 or Zone 1 client.
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Support for different client and device types vary by zone:

• Zone 1 — AirSpeed playout, Transfer Manager

• Zone 2 — AirSpeed ingest, editors, Interplay

• Zone 3 — Instinct, Assist, certain editors (for example, Avid NewsCutter); typical formats 
include DV25, DV50/IMX-50, MPEG-2 proxy (2 Mb/s)

• Zone 4 — Instinct, Assist; typical formats include DV25, MPEG-2 proxy (2 Mb/s)

Adding a Remote Host

If your client is not on the same subnet as the ISIS shared storage network, you need to add the 
name of your System Director in order for the Client Manager to connect to it. If your system 
does not use a DNS server to configure your network connections, you can also type the IP 
addresses of the remote host, but you cannot use the virtual server name or virtual IP addresses.

n Clients on the same subnet as the ISIS System Director, automatically have the System Director 
listed in the toolbar of the Client Manager window. 

To add a remote host:

1. Open the Client Manager (see “ISIS Shared Storage Network Connection” on page 51).

The Client Manager opens.

2. Click the Remote Host Settings button.

The Remote Hosts dialog box opens.
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3. In the text box, type the actual server name or IP address of the Avid ISIS System Director to 
which you want to connect. 

You cannot use the virtual server name or the virtual IP address of the remote host.

4. Click the Add button.

The Input dialog box opens.

5. In a Dual System Director configuration, you need to type the actual server name or 
IP address of the Standby System Director. 

You cannot use the virtual server name or the virtual IP address of the Standby System 
Director.

6. Click the Add button.

n The Client Manager user interface could take up to 30 seconds to display changes made in the 
Remote Host Settings. 

7. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

To remove a System Director from the Remote Hosts list:

t Select the System Director name and click the Remove button.

To remove all System Director names from the Remote Hosts list:

t Click the Clear button.

Setting the Client Manager Display Properties

Display properties in the Client Manager control how the application displays information on 
your local system.

To set Client Manager display properties:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS 
Shared Storage Network Connection” on page 51.)

2. Click the General Preference Settings button from the toolbar of the Client Manager 
window.

3. In the General area, select the appropriate options:
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4. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

Option Description

Start Client Manager Hidden (Windows and Linux) Select this option to allow the Client Manager to run 
hidden and accessible from the Client Manager icon in the taskbar. 
Deselect this option to open the Client Manager each time you start your 
system.

Use UNC (Letterless) 
Drive Mappings

(Windows) Select this option to use UNC paths to map workspaces instead 
of drive letters.

Enable Automatic Refresh Select this option to automatically refresh the data in the Systems and 
Workspace panels; for both Windows and Macintosh clients. This option is 
enabled by default.

Enable Bandwidth Columns Select this option to display the bandwidth buttons and columns in the 
Client Manager. Also enables the “Display Bandwidth in Bits Per Second” 
option.

Display Bandwidth in Bits 
Per Second

Select this option to display bandwidth in bits per second. When deselect, 
the displayed bandwidth is in bytes per second.

Measure Free Space In You can choose to display the amount of available space in your workspace 
either in gigabytes (GB) or in the total length of stored media 
(hours:minutes:seconds) at a selected resolution.

Client Type You can select a client type to set a default bandwidth reservation for the 
workspaces you mount. For information on client types, see “Bandwidth 
Reservations” on page 67 and “Setting Client Types” on page 59.

Windows Firewall:

• Enable domain network

• Enable public network

• Enable private network

(Windows) You need to enable the firewall profile configurations used in 
your ISIS shared storage network.
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Setting Client Types

Set your client type to match your network path capability and bandwidth requirements:

• Low Resolution — This is a typical setting using Interplay Assist Zone 4 (no QoS 
Guarantees) via a less than optimal network path.

• Medium Resolution — This is the default setting and is the right setting to use in most 
clients under most circumstances. Use this setting for all non-realtime applications such as 
the Copy/Move services, MPI Server, AirSpeeds, FTP transfers, and any third party transfer 
devices.

• High Resolution — Use this for DNxHD® as well as uncompressed Standard Definition 
(SD) resolutions being used with a realtime editor. 

• Ultra High Resolution — This setting is appropriate for clients with dual 1 Gb connections 
or a 10 Gb connection using the highest resolutions (DNxHD and uncompressed SD) on a 
realtime time editor. (Use the medium setting for Copy/Move/MPI service even though you 
have a 10 Gb connection.) 

To set a client type:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS 
Shared Storage Network Connection” on page 51.)

2. Click the General Preference Settings button from the toolbar of the Client Manager 
window.

The General Preferences dialog box opens.

n Windows XP clients do not have a Windows Firewall section in the General Preferences window.
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3. In the General area, click the Client Type menu, and select the appropriate client type:

t Low Resolution

t Medium Resolution (default)

t High Resolution

t Ultra High Resolution

4. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

Network Interface Setting

Only network interfaces involved with communicating with the ISIS system should be enabled.

To select the Network Interface:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS 
Shared Storage Network Connection” on page 51.)

2. Click the Network Interface Settings button from the toolbar of the Client Manager window.

The Network Interfaces dialog box opens.
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3. Make sure your ISIS Ethernet network connection is selected.

4. Click the green check mark to apply the changes or click the red X to close the dialog box 
without any changes.

ISIS Connection Tests
Before you begin using the Avid ISIS shared storage network, you should test the connection to 
your workspace to make sure communication between your client system and the media network 
is sufficient for the functionality needed by your system. You can use the Avid PathDiag tool, 
which installs with your client software, to test the read/write throughput, or the rate that read 
and write operations are conducted between your client system and a mounted workspace.

For a complete guide to using the Avid PathDiag tool, see “Avid PathDiag Tool” on page 71.

Mounting and Unmounting Workspaces
Your Avid ISIS user account must have access to at least one workspace. For information on 
workspace access, see “Creating Client Accounts for Users” in the Avid ISIS Administration 
Guide.

When you have one or more workspaces mounted and the connection to the System Director is 
subsequently lost, a message appears in the Log pane of the Client Manager window. The Client 
Manager icon in the Taskbar changes color (for Windows systems).



Mounting and Unmounting Workspaces

62

The Client Manager then automatically attempts to reestablish the connection with the System 
Director. When the connection is successfully reestablished, a Log message informs you of the 
connection state.

c Linux clients must always unmount workspaces before exiting Client Manager or your 
mount points could be different the next time you start the Client Manager and mount 
them. If you do not unmount the workspace, that workspace will appear as 
</mnt/workspace name1> in the Online column the next time you start the Client Manager. 
To correct the issue, you need to delete the /mnt/ <workspace name> directory on the client 
system.

For information on opening the Client Manager, see “Connecting to the ISIS Shared Storage 
Network” on page 52.

To mount an Avid ISIS workspace on your system:

1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for Workspaces that are 
already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:

t Select a workspace and click the Mount button.

t Right-click a workspace and select Mount.

t Double-click the workspace.

t (Option) Right-click, and select “Assign Mount Point” from the menu.

n Selecting this option will override the current drive mapping option settings for the selected 
workspace. For more information on drive letter assignments, see “Configuring Workspace 
Mount Points” on page 64.

The Client Manager mounts the selected workspace on your client and the Online icon for 
the mounted workspace changes to green. (Windows) The Workspaces list displays the drive 
the workspace is mounted to. If you use letterless drive mappings, the Workspaces list 
displays “UNC path” next to the Online icon. (Macintosh) Displays the path to the mount 
point.

If you manage your lettered or UNC workspace mounts outside of the Client Manager 
application (for example, Map Network Drives) you can create multiple mount points to the 
same workspace. Client Manager will display the multiple mounts properly. 

3. (Option) If you want the selected workspace remounted the next time you login, do one of 
the following:

t Select the workspace and click the Toggle Auto Mount button.

t Right-click the workspace and select “Enable Auto Mount.”
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The next time you login to your client system, the Client Manager automatically mounts the 
selected workspace.

To mount multiple Avid ISIS workspaces on your system:

1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that are 
already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:

t Select multiple non-contiguous workspaces with Control+click.

t Select a range of contiguous workspaces by clicking on the first workspace row in the 
range, then Shift+clicking on the last.

t Select all workspaces by right-clicking in the Workspaces list and selecting “Select All.”

t Select all workspaces by pressing Control+A.

3. Right-click, and select Mount.

The Client Manager mounts the selected workspaces on your client and the Online icons for 
the mounted workspaces change to green. The Workspaces list displays the drives the 
workspaces are mounted to. If you use letterless drive mappings, the Workspaces list 
displays “UNC path” next to the Online icons.

If you manage your lettered or UNC workspace mounts outside of the Client Manager 
application (for example, Map Network Drives) you can create multiple mount points to the 
same workspace. Client Manager will display the multiple mounts properly. 

4. (Option) If you want the selected workspaces remounted the next time you login, right-click, 
and select “Enable Auto Mount.”

The next time you login to your client system, the Client Manager will automatically mount 
the selected workspaces.

To unmount an Avid ISIS workspace on your system:

1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that are 
already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:

t Select a workspace and click the Unmount Selected Workspace button.

t Right-click on the workspace and select Unmount.

The Client Manager unmounts the workspace from your client, and the green icon is 
removed from the Online field for this workspace.

n When you exit the Client Manager you are offered the option of unmounting Workspaces.
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To unmount multiple Avid ISIS workspaces on your system:

1. Make sure your Avid application is not running.

2. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that are 
already mounted. You can filter the Workspaces list by Workspace name.

3. Do one of the following:

t Select multiple non-contiguous workspaces with Control+click.

t Select a range of contiguous workspaces by clicking on the first workspace row in the 
range, then Shift+clicking on the last.

t Select all workspaces by right-clicking in the Workspaces list and selecting “Select All.”

t Select all workspaces by pressing Control+A.

4. Click the Unmount Selected Workspace button or right-click and select Unmount.

The Client Manager unmounts the workspaces from your client, and the green icons are 
removed from the Online field for those workspaces.

n When you exit the Client Manager you are offered the option of unmounting Workspaces.

Configuring Workspace Mount Points

The Client Manager allows you to configure the drive letter used when mounting Avid ISIS 
workspaces. This allows you to prevent workspaces from being assigned drive letters you want 
reserved for other uses.

n The Client Manager skips fixed drives and drive letters that are already in use.

If your system requires using Universal Naming Convention (UNC) paths for all mounted 
workspaces rather than drive letters, you can use Client Manager to set this as the default 
mapping for workspaces.

If you manage your lettered or UNC workspace mounts outside of the Client Manager 
application (for example, Map Network Drives) you can create multiple mount points to the 
same workspace. Client Manager will display the multiple mounts properly. 

To configure the drive letter for mounting workspaces:

1. Open the Client Manager (see “Connecting to the ISIS Shared Storage Network” on 
page 52).

2. Select a workspace from the Workspace list.

3. Right-click the selected workspace, and select “Assign Mount Point” from the context menu.

The Assign Mount Point dialog box opens.
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n The Macintosh and Linux dialogs are different, the UNC does not apply but you can select the 
default or manually entered mount point.

4. Click the Choose drive letter menu, and select the drive letter you want to use for mounting 
workspaces.

5. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

Workspace Display
The Workspaces list provides basic information about each workspace, including the following:

• All available workspaces

• Connection status (connected, not connected, automounted)

• Drive letter (Windows), UNC path, or Mount point for the mounted workspace

• Workspace name

• System Director name

• Workspace details retrieval time

• Free space in gigabytes (displayed units depend on the General Preference settings)

• Workspace total capacity in gigabytes

• Used space (as a percentage of available capacity)

Option Description

Next available drive 
letter (letter:)

Mounts the workspace to the next available drive letter, working 
backward from drive Z:

Select drive letter Mounts the workspace to the selected available drive letter.

UNC (\\path) (Windows) Uses a Universal Naming Convention (UNC) path for 
the mounted workspace instead of a drive letter.
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• Protection type

• User privileges for the workspace (read, read/write) 

Retrieving Workspace Details

When you connect to an ISIS system, only the workspace names are displayed; you need to 
retrieve additional workspace details manually. You do not have to mount a workspace to retrieve 
its details.

To retrieve details for one or more selected workspaces:

1. Do one of the following:

t Select a single workspace by clicking on a workspace row.

t Select multiple non-contiguous workspaces with Control+click.

t Select a range of contiguous workspaces by clicking on the first workspace row in the 
range, then Shift+clicking on the last.

2. Right-click in the Workspace list, and select Retrieve Details > Selected Workspaces.

Additional details are retrieved for the selected workspaces.

To retrieve details for all mounted workspaces:

t Do one of the following:

- Click the Retrieve Details for Mounted Workspace(s) button

- Right-click in the Workspace list, and select Retrieve Details > Mounted Workspaces.

Additional details are retrieved for all mounted workspaces.

To retrieve details for all workspaces:

t Do one of the following:

- Click the Retrieve Details for All Workspaces button

- Right-click in the Workspace list, and select Retrieve Details > All Workspaces.

Additional details are retrieved for all workspaces.

Sorting the Display

If the Workspaces list contains a large number of workspaces, you might want to sort the items in 
the list.

To sort the Workspaces list:

1. Click on a field heading that you want to sort.

A blue arrow appears next to the field heading.
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2. Click the field heading again to reverse the sort order.

Filtering the Display

If the Workspaces list contains a large number of workspaces, you might want to filter the items 
in the list.

To filter the Workspaces list:

t Type part or all of a workspace name in the “Search Workspaces” field.

The Workspaces list updates to display the workspace names that match the text entered.

To display all Workspaces:

t Delete the text in the “Search Workspaces” field.

The Workspaces list updates to display all available Workspaces.

Accessing the Help

The Client Manager Help provides background information for tasks, windows, and dialog 
boxes. The Help system is QT-based and opens in a separate windows.

To open the Client Manager help:

t In the Menu panel, click the Help button.

Bandwidth Reservations
You can use the Client Manager to obtain a default bandwidth reservation; however, the 
reservation cannot exceed your system’s device limit or your client bandwidth limit, whichever is 
lower. The reserved bandwidth is the total bandwidth available to the client; the sum of both 
reads and writes. The Avid ISIS system enforces an effective bandwidth limit based on either the 
client type specified by the Client Manager or the reserved bandwidth value set in the 
Management Console. Your Avid ISIS administrator sets the bandwidth limits, and the 
bandwidth limit is listed in the Workspaces list. For more information on using the Management 
Console to set bandwidth limits, see the following topics in the Avid ISIS Administration Guide:

• Creating Client Accounts for Users

• Creating Client Accounts for Devices

• Setting System Preferences



Bandwidth Reservations

68

n Setting a bandwidth limit on editing clients can adversely affect playback performance. Avid 
recommends that you do not set bandwidth limits for users other than Avid AirSpeed® clients. 
However, your administrator might need to set a bandwidth limit for other devices, such as an 
Avid ISIS TransferManager, in the event the device is consuming more bandwidth than expected.

Enabling Bandwidth Reservations

The Bandwidth dialog must be enabled in order to manage bandwidth reservations.

To enable the Bandwidth Dialog:

1. Open the Client Manager.

2. Click the General Preference Settings button.

3. Select “Enable Bandwidth Columns.”

4. (Option) Select “Display Bandwidth in Bits Per Second” to display bandwidth in bits per 
second instead of megabytes per second.

5. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

The Bandwidth buttons appear in the Systems toolbar.

6. To set the Bandwidth (see “Creating or Releasing Bandwidth Reservations” on page 68).

Creating or Releasing Bandwidth Reservations

To create or modify a bandwidth reservation:

1. Open the Client Manager and Enable Bandwidth Columns in the General Preference 
Settings (see “Enabling Bandwidth Reservations” on page 68).

2. Click the Configure Reserve Rate for Selected System(s) button.

The Configure Reserve Rate dialog box opens.
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3. Use the up/down buttons to select the number of streams you will need.

4. Select the type of stream from the list.

There are several presets for various formats, as well as numeric bandwidth values.

n If the selected bandwidth value exceeds the limits imposed either by the client type specified by 
the Client Manager or the reserved bandwidth value set in the Management Console, a warning 
symbol will appear next to the Total Rate value. You will be able to save these values, but not to 
create or modify an existing reservation.

5. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.

6. Close the Configure Reserve Rate dialog by clicking the red X.

7. Click the “Reserve bandwidth for selected System(s)” button.

n You can enable Auto Reserve and create the reservation in one step if you select “Toggle Auto 
Reservation for selected System(s)” before clicking Reserve.

8. (Option) If you want the reservation to be created automatically the next time you login, 
click the “Toggle Auto Reservation for selected System(s)” button.

n You can enable Auto Reserve and create the reservation in one step if you select “Toggle Auto 
Reservation for selected System(s)” instead of clicking Reserve.

To release a reservation:

1. Select the System reservation you want to release.

2. Click Reserve bandwidth for selected System(s).

The selected reservation is released.

Administrative Tasks
You should clear cashed data and review your logs and messages on a regular basis.

Clearing Cached Data

The Client Manager maintains information on site settings in cache files, and the tool appends 
data each time you open the Client Manager. You can clear the cached information — for 
example, to remove settings for users no longer working on a specific system — by deleting the 
cache files.
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To clear cached data:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS 
Shared Storage Network Connection” on page 51.)

2. Click the Advanced Settings button.

3. In the Advanced section, do one of the following:

t Click the Clear button for each cache file you want to clear.

t Click the Clear All button to clear all cached data.

4. Click the red X to close the dialog box.

Using Logs and Messages

The Client Manager keeps a log of information, warnings, and error messages. You can view the 
current login, in the Messages section of the Client Manager window. You can also save a copy 
of the log, and you can clear the log maintained for the current work session.

n The Client Manager clears all logs when you exit the application.

To view Client Manager event logs:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS 
Shared Storage Network Connection” on page 51.)

The Messages area is the bottom section of the Client Manager window. You can sort the 
Messages list by clicking the Level, Time, or Message field heading and clicking on the blue 
arrow to sort in ascending or descending order.

To save a copy of the event log:

1. Right-click in the list, and select Export.

The Export dialog box opens.

2. Navigate to the folder where you want to save your log.

3. Type a name for the login the File Name text box.

4. Click Save.

The Client Manager saves the event messages as a log file (filename.log).

To clear all event logs:

t Right-click in the list and select Clear.



3 Avid PathDiag Tool

This chapter contains the following topics:

• Starting Avid PathDiag Tool

• PathDiag Tool Interface

• Diagnostic Tests

• Starting and Stopping the Test

• Test Results

Avid PathDiag tool is a diagnostic utility that allows you to validate your Avid ISIS storage 
group by quantifying the throughput of Windows or Macintosh editing applications accessing 
Avid ISIS workspaces. The Avid PathDiag tool can also test the throughput from local storage 
elements and any other shared storage to which a client has access.

Starting Avid PathDiag Tool
To start Avid PathDiag tool, do one of the following:

t (Windows) Select Start > All Programs > Avid > ISIS Client > PathDiag.

t (Macintosh) Select Go > Applications, and then double-click the AvidISIS folder. In this 
folder, double-click the PathDiag icon.

The Avid PathDiag tool opens.



PathDiag Tool Interface

72

PathDiag Tool Interface
The primary user interface of PathDiag tool consists of a single window from which you can 
select the test to be performed, start and stop the selected test, and view the test results as the test 
progresses. You access auxiliary controls through dialog boxes.
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Settings Area

The Settings area in the main window displays the name of the currently selected test, the test 
duration, and the path to the storage that will be tested.

The Setup button allows you to change the test settings. For more information, see “Diagnostic 
Tests” on page 76.

1 Settings area

2 Messages area

3 Results area

4 Control area

5 Start and Stop buttons

6 Test results graph

7 Zoom slider control



PathDiag Tool Interface

74

Control Area

The Control area in the main window has Start and Stop buttons along with test timing 
information. For more information, see “Starting and Stopping the Test” on page 83.

Messages Area

The Messages area provides test progress and diagnostic information about the operation of the 
utility. If you need to troubleshoot, the detailed text information in these messages might be 
helpful.

Results Area

The Results area provides the following numerical test results:

Text indicators on the left of the Results area show the file access protocol used and the operation 
performed in the current phase of testing.

The File Access Protocol indicator shows one of the following:

Item Description

IOs Displays the current number of I/O operations that have been completed during the 
test

Current Rate (MB/s) Displays the calculated throughput or bandwidth (in megabytes per second 
[MB/s]) for recent I/O operations that have been completed

Average Rate (MB/s) Displays the average throughput or bandwidth (in megabytes per second) for the 
duration of the test

Errors Displays the number of errors encountered during testing. This is the total of all 
errors generated for both read and write operations and can include errors related 
to the following:

• Opening or closing data files

• Validity of the specified file system path

• User access privileges

• Read or write operations

Item Description

Automatically 
Select

Selects a protocol automatically for testing the selected path. Generally, the tool selects 
Win32 File API for the specified path



PathDiag Tool Interface

75

The I/O Operation indicator shows one of the following:

Test Results Graph

The Test Results graph plots results measured over time. It is particularly useful when you want 
to observe trends or patterns in performance.

For example, if another process is running that creates a periodic high demand on the storage 
subsystem being tested, you might see this as a periodic drop in observed throughput in the Test 
Results graph.

The Test Results graph shows the following:

Win32 File
API

Indicates the Win32 file access API is being used. This indicator is displayed for local 
disks, mounted ISIS workspaces, and network file shares.

Self-Test Indicates the performance monitor runs a test without actually performing any read or 
write operations. This is usually done to benchmark the tool without disk input/output 
actions affecting the results.

Item Description

Item Description

(Reading) The current mode of testing is Read operations.

(Writing) The current mode of testing is Write operations.

Item Description

Average Read or 
Average Write

The average throughput or bandwidth (in megabytes per second), plotted over time.

Recent Read or 
Recent Write

The calculated throughput or bandwidth (in megabytes per second) for recent I/O 
operations, plotted over time.

Peak Read or Peak 
Write MS/100

The peak latency for individual I/O operations (either reads or writes) that have been 
completed over a short period of time. A high measurement indicates a longer period 
of time was needed for the operation to complete.

Because only the highest (peak) measurement over a short period of time is 
displayed, a single high peak could be accompanied by many low-latency operations 
that do not appear in the graph.
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n When you run the Network Connectivity test, the Test Results graph display is replaced with a 
table of results generated by the test. For more information, see “Setting Up a Network 
Connectivity Test” on page 81.

Diagnostic Tests
The Settings area of the PathDiag tool displays the currently specified test parameters. Before 
running the test, you must mount at least one workspace in the Avid ISIS shared storage 
network.

Setting Up a Standard Test

To change the default test settings:

1. Click the Setup button.

The PathDiag tool Settings dialog box opens.

2. Adjust the test parameters using the information provided in the following table, the ISIS 
Read/Write Test Name selection is recommended.
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The ISIS Read/Write test is a good standard test because it includes unlimited bandwidth 
used to ascertain the available performance of the end-to-end path. The following are typical 
results:

- Single 1 Gb connection produces an average of 96 MB/s

- Dual 1 Gb connection produces an average of 192 MB/s

- 10 Gb connection produces an average of 250 MB/s on writes and 350 MB/s on reads

3. If necessary, specify paths and file names for optional test and error log files as follows:

a. Click Optional Log Files. 

The Avid ISIS PathDiag Optional Log Files dialog box opens.

Parameter Description

Test Name The following are predefined selections that perform either read or write testing at a 
bandwidth similar to that required for DV 25, DV 50, IMX 30, or low resolution 
operation. 

• DV 25 Reads

• DV 25 Writes

• DV 50 Reads

• DV 50 Writes

• 4:1s Writes

• 10:1m Writes

• 14Z:1 Writes

• IMX 30 Reads

• IMX 30 Writes

• ISIS Read/Write (see the statement below this table)

Path to Test Select the path to the workspace you want to test, or type it in the text box.

This can be a UNC path (for example, \\myMachine\ myShareFolder\subfolder).

Duration
(Minutes)

Select the test duration (in minutes), or type a duration in the text box. The minimum test 
duration is 1 minute.

Loop Select the Loop option to repeat the test indefinitely. When you select this option, the test 
proceeds until you press the Stop button in the main utility window.

The Loop option causes true loop behavior: at the end of the specified duration, the test 
stops, intermediate test files that have been created are cleaned up, and then the test 
restarts using cleaned-up intermediate test files. 
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b. If you want to log information about the test and its results, type a path name and a file 
name in the Log File text box, or click Browse to search for a file name.

c. If you want to log error information, type a path name and a file name in the Error File 
text box, or click Browse to search for a file name.

If you do not want a log file, leave the Log File, Error File, or both text boxes blank.

d. Click OK to close the dialog box.

Setting Up a Custom Test

In addition to the standard, predefined tests, the PathDiag tool allows you to configure custom 
tests.

• To view the selection of standard tests, click Standard Tests in the PathDiag tool Settings 
dialog box.

• The recommended PathDiag settings for 10 Gb connection would be a Transfer Size of 
32768 and the Transfer Rate to unlimited.

To access the custom test settings options:

1. Click Custom Test in the PathDiag tool Settings dialog box. 

The dialog box expands to display the Custom Test Settings area.
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2. Adjust the custom test parameters described in the following table, as required:

Parameter Description

File Access 
Method

PathDiag tool supports more than one interface or protocol for accessing data. This 
option allows you to control which interface is used. Choose one of the available 
settings: 

• Automatically select — PathDiag tool selects a protocol automatically for testing 
the selected path. Generally, the tool selects Win32 File API for the specified 
path.

• Win32 File API — PathDiag tool uses the Win32 File API for its data file access.

• Network Connectivity Test — PathDiag tool runs a high-level test to verify 
network connectivity. For more information on the network connectivity test, see 
“Setting Up a Network Connectivity Test” on page 81.

• Self-Test — PathDiag tool runs a test without actually performing any read or 
write operations. This is usually done to benchmark the tool without disk 
input/output actions affecting the results.
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Reads vs Writes PathDiag tool supports testing that focuses on Reads or Writes, or that alternates 
between Reads and Writes. Select a testing mode: 

• Writes, then Reads — The utility alternates between Write and Read tests. 
Approximately half of the test duration is allocated to reading, and the other half 
is allocated to writing.

• Writes Only — The utility writes test data files and measures the throughput 
obtained during Write operations.

• Reads Only — The utility reads test data files and measures the throughput 
obtained during Read operations.

n One or more test data files are written as sample data for testing; however, the 
Writes required to set up the test are not included in the throughput 
measurements.

Transfer Size
(KB)

This option controls the amount of data the test utility attempts to read or write during 
a single I/O. Some software (like audio applications) uses smaller I/Os. Video 
applications use larger I/Os. Depending on the client application, you can select a 
typical I/O size for your application and run a PathDiag to see the results that you can 
expect from your client running that application.

In some cases, you might set the Transfer Size to large I/O sizes to test switch 
performance. 

Transfer Rate
(KB/S)

The utility can attempt to perform I/O at a variety of fixed transfer rates. This is useful 
for simulating the behavior of applications that have a known data rate. You can select 
a data rate where I/Os do not exceed a particular limit.

A special unlimited transfer rate setting is also available. When you select the 
unlimited transfer rate, the PathDiag tool performs I/O operations as fast as possible 
while being affected by all aspects of the total system being exercised.

Max File Size
(MB)

This option controls the maximum size of test data files created for Reads or Writes. 
This option might affect throughput measurements. For example, at any given data 
rate, a smaller file is opened and closed more often than a larger file, creating more 
overhead. The default file size is 100 MB.

The Max File Size setting is very useful when creating custom PathDiag tests. If you 
use any of the default sizes on an ISIS 5500 | 5000, you are doing I/O nearly 100% out 
of cache, rather than disk I/O. This is great in determining the health of your network, 
by taxing the network. If you want to test pure disk I/O throughput, run multiple 
instances of PathDiag using the largest supported file size of 2000 MB.

Parameter Description (Continued)
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3. Click OK.

Setting Up a Network Connectivity Test

The PathDiag tool provides a high-level verification of network connectivity when you select 
Network Connectivity Test as a custom test parameter. The Custom Test Settings area of the 
Avid ISIS PathDiag Settings dialog box allows you to list up to 8 network hosts to test. Results 
display in the Test Results graph area of the PathDiag tool.

To set up the Network Connectivity Test:

1. Click Custom Test in the PathDiag tool Settings dialog box. 

The dialog box expands to display the Custom Test Settings area.

2. Select Network Connectivity Test from the File Access Method menu.

The Network Hosts list displays the available systems in your network.

Use named 
common file for 
Reads

This option changes the way that the Path to Test parameter is used, and the option is 
intended for advanced users only. When you select this option, the Path to Test 
parameter must specify a full path, including a file name. The test utility uses the 
named file for its Read tests.

The utility creates the file if it does not exist and deletes it at the end of testing. For 
this reason, the named file should not already exist unless you want it to be deleted 
when the test is completed. With this option selected, you can run PathDiag tool on 
multiple clients simultaneously and supply the same file name.

This allows PathDiag tool applications running on multiple clients to read a common 
file. (The file is created as needed, and the last PathDiag tool application to stop 
deletes the file.)

Parameter Description (Continued)
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3. Type the host name or the IP address of the network system you want to test.

4. (Option) Set the Ping Data Buffer Size. The default buffer size is 8192 bytes, and the 
maximum buffer size is 64 KB.

5. Click OK.

When you run the Network Connectivity test, results display in the Test Results graph area 
of the PathDiag tool. 

The following table describes the test results.
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Starting and Stopping the Test
You start and stop the currently configured test using the Start and Stop buttons.

To start the currently configured test:

t Click Start in the PathDiag tool main window.

The test runs for the specified duration and then stops automatically. The elapsed time a test 
has been running and the remaining time are displayed in the Control area. If you selected 
the Loop option in the PathDiag tool Settings dialog box, the test runs indefinitely. In this 
case, the word LOOP appears in the Time Remaining display in the main window.

To stop the currently running test:

t Click Stop in the PathDiag tool main window.

Network Connectivity Results

Category Description

Source The IP address of the client system

Target The host name and IP address of the target system

Sent The number of packets sent

Recv The number of packets received

Lo RTT (ms) The minimum round-trip time (in milliseconds) 

Hi RTT (ms) The maximum round-trip time (in milliseconds) 

Avg RTT 
(ms)

The average round-trip time (in milliseconds) 

Lo Hops The minimum number of forwarding routers in the path between the source and the 
target system

Hi Hops The maximum number of forwarding routers in the path between the source and the 
target system

Avg Hops The average number of forwarding routers in the path between the source and the 
target system

% Lost The percentage of the packet lost in the test
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Test Results
This section provides information to help you interpret test results displayed in the PathDiag tool 
main window.

Average Rate Calculation

The average data rate is calculated over the duration of the test. This calculation includes the 
time the utility requires to open and to close the test files, so the test file size (which you can 
configure for custom tests) can affect the overall measured throughput.

Also, if the throughput is slow as the test is starting, this might be reflected in the average rate. 
For example, if the target bandwidth is 4.0 MB/s, the actual average rate calculated at the 
conclusion of the test might be 3.98 or 3.99 MB/s.

Performance Graph

The graph of results over time can help experienced users obtain information about system 
performance.

The following display is a normal unlimited read/write profile for an ISIS client.
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The following are a few items to look for:

• Trends: Does the system perform at a consistent rate over time? Is there an upward or 
downward trend in performance measured over time? If you notice a trend, it might be 
helpful to perform testing over a longer period of time to determine if the trend continues 
over longer durations or if a recurring pattern emerges.

It is normal for the maximum read bandwidth to be greater that maximum write bandwidth.

• Patterns: Is there a momentary drop in performance that occurs at consistent or varied 
intervals? Patterns can emerge as a result of implementation details and the configuration of 
a particular system (for example, caching strategies or physical memory), or they might 
indicate a load on a system that is occurring periodically.

• Changes in performance as load varies: What occurs when a subsystem is placed under a 
load by other users (or PathDiag tool is running on another client)? It might be easier to 
observe these interactions by inspecting the plot of performance results over time.

Measurement Strategy

Throughput measurements are plotted periodically (every n seconds) and represent a snapshot of 
performance at the time of the plot. This is done to limit the amount of data that is plotted, which 
otherwise could include a very large number of data points. As a result, the performance graph 
could miss a momentary drop or increase or a peak in performance that occurs between plot 
points. The average rate calculation reflects the impact of such a dip or spike, even if the actual 
size of a momentary variation does not appear in the graph.

Test Result Interpretation

If your results fall below optimal performance, you can check to see if your bandwidth is limited. 
You can use the Avid ISIS Management Console to check your user bandwidth in the Users list 
in the Users dialog box (see “User Descriptions” in the Avid ISIS Administration Guide) and 
your device bandwidth in the Device list in the Device dialog box (see “Device Descriptions” in 
the Avid ISIS Administration Guide). If your bandwidth requirements are greater than the 
reservations set in the Management Console, your Avid ISIS administrator can adjust the limits.

These results represent guidelines for Avid-qualified systems; performance on your system 
might vary.



4 Data Migration Utility

This section contains the following topics:

• Data Migration Between Avid Storage Networks

• Data Migration Utility Installation

• Logging Into the Data Migration Utility

• Data Migration Window

• Data Migration Buttons

• Running the Data Migration Utility

• Transfer Preferences

• Transfer Queue and Logs

The Data Migration Utility is used for copying data from workspaces in the Avid MediaNetwork 
infrastructure to the ISIS infrastructure. This is done using single or dual Ethernet connections to 
Avid ISIS and a Fibre Channel connection to your Avid MediaNetwork. In addition you can use 
the Data Migration utility to copy data between any combination of ISIS 7500 | 7000, 
ISIS 5500 | 5000, and ISIS 2000 workspaces (this includes mirrored, RAID 5, RAID 6, HW 
Raid, SW Raid, and unprotected workspaces). 

n When you copy data from an ISIS 5500 | 5000 or an ISIS 2000 system to an ISIS 7500 | 7000 
system, the utility automatically creates mirrored workspaces on the ISIS 7500 | 7000 by default. 
After the data has been copied, you can change the protection type if you want.

Data Migration Between Avid Storage Networks
A Data Migration Utility is included with Avid ISIS software kit for coping data from 
Avid MediaNetwork v5.1.3 and v4.2.4 infrastructures to the Avid ISIS infrastructures, or 
between ISIS infrastructures. Data Migration software is not supported in MediaNetwork v4.1.6 
and older infrastructures.

ISIS clients can be directly connected to the System Director or through an ISIS switch. As you 
copy the selected Workspaces from one shared storage infrastructure to the other, the utility 
creates Workspaces with the same name on the targeted ISIS infrastructure automatically. A 
progress bar is displayed to monitor the status of your migrations.
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n Do not migrate data from the same workspace with multiple clients at the same time.

Data Migration clients requirement:

1. Update your Windows or Macintosh client to the appropriate Avid MediaNetwork and Avid 
ISIS client software versions.

2. Connect your shared storage network cables:

t Avid Unity MediaNetwork client — Fibre Channel connection to the Avid Unity 
MediaNetwork.

t ISIS Windows client — to the Intel Pro 1000 PT network adapter on your Windows 
client (see “Windows Client Systems Qualified for Data Migration” on page 88).

t ISIS Macintosh client — to the built-in Ethernet port on your Macintosh client.

3. Load the ISIS client software and any updates required for the release.

4. Load the Avid Data Migration software, see “Data Migration Utility Installation” on 
page 89. 

Operating Systems Qualified for Data Migration

The following lists the client operating systems that have been qualified to do data migration. 

n Although the Data Migration Utility is supported with the following operating systems, it does 
not mean that all these operating systems are supported in your shared storage environment. For 
example, Avid MediaNetwork does not support Windows 8 clients. Windows 8 clients can only 
use the Data Migration Utility to migrate data between ISIS environments.

• Windows 8 (64-bit)

• Windows 7 (64-bit) with SP 1

• Windows Vista (64-bit) with SP 2

• Windows XP (32-bit) with Service Pack (SP) 3

• Windows 2008 R2 (64-bit)

• Mac OSX-Lion v10.7.x, and Mountain Lion v10.8.x

Macintosh Client Requirements

Data Migration has been qualified on Mac OS v10.6.5 and later clients with Avid MediaNetwork 
v5.3.3 or later and Avid ISIS v3.2 or later. An Ethernet connection is made to the Avid 
ISIS 5500 | 5000 v3.2 or Avid ISIS 7500 | 7000 v2.4 and later infrastructures, and a Fibre 
Channel connection to your Avid MediaNetwork v5.1.3 or v4.2.4 infrastructures. Using the Data 
Migration Utility clients can copy data files from the Avid MediaNetwork to ISIS infrastructures, 
or between ISIS infrastructures.
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Windows Client Requirements

Data Migration has been qualified on Windows clients with Avid MediaNetwork v5.4 or later 
and Avid ISIS 5500 | 5000 v3.2 or later. An Ethernet connection is made to the Avid 
ISIS 5500 | 5000 v3.2 or Avid ISIS 7500 | 7000 v2.4 and later infrastructures, and a Fibre 
Channel connection to your Avid MediaNetwork v5.1.3 or v4.2.4 infrastructures. Using the Data 
Migration Utility clients can copy data files from the Avid MediaNetwork to ISIS infrastructures, 
or between ISIS infrastructures.

n Dual connected clients are only supported with the ATTO FC-41ES network adapter in 
supported Windows client systems and slots listed in “Windows Client Systems Qualified for 
Data Migration” on page 88. The ATTO FC-41XS and FC-41EL Fibre Channel network 
adapters, and Windows client systems not listed in the table are not supported.

Data Migration software is supported on Windows 7, Windows Vista, Windows XP, and 
Windows Server 2008 R2 client operating systems.

Windows Client Systems Qualified for Data Migration

The following table lists the Windows client systems that have been qualified to do data 
migration using an Ethernet and Fibre Channel connection on the same client. You must install 
an Intel Pro 1000 PT network adapter into your Avid MediaNetwork client. Use the following 
table and the Avid Unity Media Engine and Avid MEDIArray XT 5.4 Readme for slot locations. 

Required xw8600 system BIOS change to set maximum PCI-E speed for slot 5:

1. During startup, press F10 at the white HP screen, for Set Up.

2. Select English and press Enter.

Qualified Windows Platforms for Data Migration Between Avid MediaNetwork and 
Avid ISIS  

Windows Platforms

Slot for Intel Pro 
1000 PT Ethernet 
adapter (ISIS 
Connection)

Slot for ATTO 
FC-41ES Fibre 
Channel adapter 
(MediaNetwork 
Connection) Comments

Z800 (Dual quad-core and 
dual 6-core)

5 4

Z400 (Gen1 and Gen2) 4 3

xw8600 (Dual quad-core) 5 6 Set slot to x8 electrical in 
the system BIOS
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3. Click the Advanced tab.

4. Select Chipset / Memory and press Enter.

5. Select PCIe Lane Allocation (SLOT4: SLOT5).

6. Default setting is AUTO.

7. Change this setting from AUTO to x8:x8.

8. Press F10 to Save.

9. Save Changes and Exit.

Data Migration Utility Installation
To install the Data Migration Utility:

1. Load the Avid ISIS v3.2 or later client software and any updates required for the release.

2. Restart the ISIS client.

3. Load the Avid Data Migration software. The Avid Data Migration software can be found in 
the Avid ISIS software installer kit in the following location \AvidISISUtilities\ISIS 
Data Migration Utility\ folder. Double-click on the appropriate installer and follow the 
prompts.

t Windows 32-bit clients — AvidISISDataMigrationUtility_Win32.msi

The Windows software is loaded in the following location: \Program 
Files\Avid\Data Migration Utility. 

t Windows 64-bit clients — AvidISISDataMigrationUtility_Win64.msi

The Windows software is loaded in the following location: \Program 
Files\Avid\Data Migration Utility. 

t Macintosh 32-bit clients — AvidISISDataMigrationUtility_MacOSX.dmg

The Macintosh software is loaded in the following location: /Applications/Avid/ 
Data Migration Utility. 

4. Log into your ISIS Management Console and create a new Storage Group for the new 
Workspaces getting copied from your MediaNetwork shared storage environment.

n There must be a Storage Group created on your ISIS system before you start the Data Migration 
Utility.
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Logging Into the Data Migration Utility
The Data Migration Utility login requires the Administrator password for both your 
MediaNetwork and your ISIS storage shared storage networks. 

n The Data Migration Utility is for copying data from the Avid Unity MediaNetwork to Avid ISIS 
and between ISIS shared storage networks. This utility does not copy data from ISIS to the 
MediaNetwork.

To connect to the Avid ISIS network:

1. Load the Data Migration software (see “Data Migration Utility Installation” on page 89).

2. Click Start > Programs > Avid > Data Migration Utility, and select Data Migration Utility.

The System Login Dialog box for both the MediaNetwork and the ISIS shared storage 
systems opens.

3. Log-in using your Administrator account (Administrator is already entered):

a. Type your MediaNetwork Administrator password in the Source text boxes

b. Click Connect or press Enter.

c. Type your ISIS Administrator password in the Destination text boxes

d. Click Connect or press Enter.

4. Click the green check mark to login or click red X to close the utility.

Data Migration Window
The following illustration describes the sections of the Data Migration Utility window.
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1 Data Migration toolbar — contains buttons for connecting or disconnecting to the shared storage 
environments, hiding the Verify and Copy Data and Transfer Queue panels, and opening the Transfer 
Preferences and Help dialog boxes.

2 Selection area — for selecting the MediaNetwork workspaces to be copied to the ISIS. 

3 Storage Group area — lists the workspaces, total amount of data to be copied, and estimated amount 
of transfer time. The name of the destination Storage Group is listed and whether there is enough 
unallocated space in the Storage Group for the selected Workspaces to be copied.

4 Workspace area — lists the Workspace names, their destination, amount of data and estimated 
amount of time to be copy each Workspace, and position of the Workspace in the transfer queue.

5 Data Migration button — Starts the file coping after you have selected the Workspaces to copy and 
Storage Group destination. This button is not active if the destination Storage Group is not large 
enough.

6 Transfer Queue area — provides you with the ability to view the transfer progress, pause or cancel 
the transfer, and view logs of the transferred and failed files
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Data Migration Buttons
The following table describes the Data Migration Utility buttons. You can also hold the cursor 
over the button and get a tool tip on the button function.

Button Location Function

System Login 
dialog box

Opens the System Login dialog box to connect to both shared storage 
systems

Data Migration 
window toolbar 

Disconnect from both shared storage systems

Data Migration 
window toolbar 

Toggles the “Transfer Queue” panel in the Data Migration window to 
display or be hidden. The Transfer Queue shows the data migration 
logs which includes a list of files that have been transferred and any 
files that might have failed the transfer. 

Data Migration 
window toolbar 

Toggles the “Select Workspaces” and “Verify and Copy Data” panels 
in the Data Migration window to display or be hidden. The Select 
Workspaces panel lists all the Workspaces and Allocation Groups or 
Storage Groups in both the MediaNetwork and ISIS systems.

Data Migration 
window toolbar 

Opens the Transfer Preferences dialog box

Data Migration 
window toolbar 

Opens the Client Manager Help. The Client Manager Help includes 
information on the Data Migration Utility.

Select Workspaces 
toolbar 

Selects all the MediaNetwork Workspaces to be copied

Select Workspaces 
toolbar 

Deselects all selected MediaNetwork Workspaces

Select Workspaces 
toolbar 

Refresh all the data; in both the MediaNetwork and ISIS Storage 
Groups

Select Workspaces 
toolbar 

Refreshes the display to show the number of new files on the source 
MediaNetwork Workspace since the time of the last migration.
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Running the Data Migration Utility
After installing the Data Migration Utility and logging in as previously described. The following 
procedure describes how to copy your data from the MediaNetwork to the ISIS. When you select 
the Workspaces to copy on the MediaNetwork, and a Storage Group on the ISIS, the utility 
automatically creates Workspaces on the ISIS system with the same names as the Workspaces 
used in the MediaNetwork environment. If the capacity of ISIS Storage Group does not have 
enough space, the Data Migration button (used to start the copy) does not become active. 

n This procedure shows a MediaNetwork to ISIS Data Migration, Data Migration between ISIS 
workspaces follows the same process.

Once you have started coping files, you can pause and continue the copy at any time. If you 
decided to cancel the copy, any files already copied to the ISIS can be used.

n You do not need to mount Workspaces using the MediaNetwork Fibre Manager or the ISIS Client 
Manager to use the Data Migration Utility.

Verify and Copy 
Data toolbar 

Data Migration button starts the copy from MediaNetwork to ISIS. 
This button is disabled if the amount of data in the source is greater 
than destination capacity.

Transfer Queue 
toolbar 

Clears the Transfer Queue panel of Completed, Failed and Canceled 
transfers. This button does not clear Active, Pending and Paused 
transfers.

Transfer Queue 
toolbar 

Pauses the process of the data being copied. Press the Pause button 
again to continue the copy.

Transfer Queue 
toolbar 

Cancels the selected transfers

Transfer Queue 
toolbar 

Opens log file displaying the files that have, and have not transferred 
successfully 

Transfer Preferences 
dialog box

Applies settings or changes made in the open dialog box

Transfer Preferences 
dialog box

Closes the open dialog box. Any changes that were not applied 
reverted back to the last saved settings

Button Location Function (Continued)
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To copy data:

1. Open the Data Migration Utility. (For information on opening the Data Migration Utility, see 
“Logging Into the Data Migration Utility” on page 90.)

2. Select one or multiple Workspaces from the Select Workspaces. 

3. Choose your destination Storage Group on the ISIS.

n The ISIS Storage Group must be already available before you start the Data Migration Utility.

4. Click Start Migration button to begin migration. 

This button is disabled if there is not enough space in the destination Storage Group or you 
have not selected all of the required parameters. If the connection is lost, the disconnection 
event displays in the Transfer Log.

Status bars show progress in Transfer Queue

5. (Option) Check the logs regarding transfer result

To stop a transfer:

t Select one or more transfers in the queue and click the Cancel button.

If no transfers are selected, this button is disabled.

To view the files that have not been copied:

1. Select the Workspace.

2. Click New File refresh button.

New Files column lists the number of new files in the selected Workspace not previously 
transferred.
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Transfer Preferences
You can set the following options in the Transfer Preferences dialog box. 

• Preserve file and directory timestamps — When checked the timestamps associated with the 
files and directories are copied to the ISIS system. If unchecked the current date is used. 

• Overwrite existing files — If there are existing files with the same name as the file being 
copied, the existing file is overwritten with the file being copied. If Workspaces or folders 
already exist, files are added to those existing Workspaces and folders.

• Overwrite files even if timestamps are the same — This setting is available when “Overwrite 
existing files” is checked. Files are overwritten regardless of the date on the timestamp.

• Overwrite read-only — This setting is available when “Overwrite existing files” is checked. 
Files are overwritten regardless if the file is read-only.

To set the Transfer Preferences:

1. Open the Data Migration Utility. (For information on opening the Data Migration Utility, see 
“Logging Into the Data Migration Utility” on page 90.)

The Data Migration Utility opens.

2. Click the Transfer Preference button in the Data Migration Utility window.

The Transfer Preferences dialog box opens.

3. Select your preferences.

4. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.
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Transfer Queue and Logs
The Data Migration Utility keeps a log of Files Transferred and Files Failed. You can view the 
current log in the Transfer Queue section of the Data Migration Utility window. The log file is 
automatically deleted and a new one is started every time you open the Data Migration Utility. 
You can save a copy of the log or the log for the current work session.

n The Data Migration Utility clears all logs when you exit the application.

To view data in the Transfer Queue:

1. Open the Data Migration Utility. (For information on opening the Data Migration Utility, see 
“Logging Into the Data Migration Utility” on page 90.)

If the Transfer Queue area is not displayed, click the show Transfer Queue button to display 
panel. 

The Transfer Queue area is the bottom section of the Data Migration Utility window. You 
can sort the list in the window by clicking the headings at the top of the Transfer Queue 
panel. Click the blue arrow to sort the Workspace field in ascending or descending order.

To save a copy of the Data Migration Utility log:

1. Click in the Transfer Log file button.

The Log file opens in your text editor.

2. Navigate to the folder where you want to save your log.

3. Type a name for file and save it.

To clear transferred file data in the Transfer Queue panel:

t Click the Clear button.

The Clear button clears any finished transfers (transfers that have been canceled, failed, or 
completed). Any pending or paused transfers remain in the queue.
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The ISIS Log Utility used by Avid Customer Support shows the logging information of the ISIS 
client connection. This utility is installed with the ISIS client software and is used to diagnose 
client issues. This updated utility has a common user interface for Windows, Macintosh, and 
Linux clients.

• You can load pre-defined profiles (based on common troubleshooting scenarios) that use 
trace filters to gather data.

• The Log Utility automatically compresses and timestamps continuous logs.

• After you “Take Snapshot” of the loaded Profile results, you can save the snapshot to a file.

• Through the counseling of Avid Customer Support, you can also add specific Profiles to the 
list.

Running the ISIS Log Utility
To run the Log Utility:

1. Do one of the following: 

t (Windows) Click Start > Programs > Avid > ISIS Client > ISIS Log Utility. 

t (Macintosh) From the Finder, click the Go menu and select Application > AvidISIS > 
ISISLogUtility.app.

t (Linux) Click Application > System Tools > ISIS Log Utility.
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2. Based symptoms the client is experiencing, select a profile from the Select Profile menu:

- Default — Use this profile if you are unsure of which profile to use. These logs capture 
general ISIS client problems. 

- Client Hang — Capture these logs if the ISIS client stops functioning and you want to 
see if the unexplained client failure is associated to ISIS functions. This should be used 
if the editor stops while capturing, playing, consolidating, or transcoding to an ISIS 
Workspace. Many of these failures could be an issue with the editor.

- File or Workspace Access — Capture these logs if the ISIS client cannot mount 
Workspaces, access files within a workspace, or received errors when accessing 
Workspace files.

- I/O Timeouts — Capture these logs if the ISIS editing client displays “semaphore 
timeout” messages, “delayed write failures,” or dropping frames while working with 
media on a Workspace. 

- Redistribution Problems — Capture these logs if the ISIS client is experiencing errors, 
displaying messages, or dropping frame while the ISIS system is in the process of a 
redistribution. Although client performance is expected to drop during and an ISIS 
redistribution, these problems would be under light ISIS loads and low resolutions. 
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- Verbose Logging — This log captures a wide array of data in no specific area. Typically 
used when the root of a problem is unknown and you are looking for clues. This logging 
should not be used unless specifically instructed to do so. These logs are excessive and 
difficult to interpret. 

3. Click Load. 

The configuration for the selected Profile is loaded.

4. (Option) Click “Current Settings” to change settings in the configuration.

5. Click “Take Snapshot” or “Start Continuous Log.”

If you started a continuous log you need to click Stop Continuous log before accessing the 
logs. The logs are automatically compressed and saved to your client system. If you click 
Take Snapshot, click Save Snapshot to save the snapshot to a file.

Depending on your operating system the default logging directories for the ISIS Log Utility 
are:

- Windows 7 and Windows 2008 servers — C:\Users\Administrator\Documents\
ISISLogUtility

- Windows XP, Windows Vista 64 bit, and Windows 2003 servers — C:\Documents and 
Settings\Administrator\ISISLogUtility

- Macintosh OSX — /Users/Administrator/ISISLogUtility

- Linux — /home/<usersname>/ISISLogUtility

6. Click “Show Display” or “Save Snapshot” to view or save the results.

Changing Settings

The recommended default settings are saved in each Profile. You should not change the 
pre-defined settings unless instructed to by Avid Customer Support.

To change ISIS Log Utility test settings:

1. Do one of the following to start the ISIS log Utility: 

t (Windows) Click Start > Programs > Avid > ISIS Client > ISIS Log Utility. 

t (Macintosh) From the Finder, click the Go menu and select Application > AvidISIS > 
ISISLogUtility.app.

t (Linux) Click Application > System Tools > ISIS Log Utility.

2. Select a profile from the Select Profile menu.

3. Click Load. 

The configuration for the selected Profile is loaded.
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n To view the test configuration that was loaded, click the Configure button. 

4. Click “Current Settings” in the Tools section to change settings in the configuration.

5. Select or deselect the changes you want in the Snapshot Options, Trace Buffer Filtering, and 
Continuous Logging sections of the window.

Click the Advanced button to display more options.

6. Click the Browse button to define where you want the log files to be saved or type in the new 
path. 

7. Click Apply to save your changes and have them loaded in the test configuration. 

Click Reset to return all the options and path back to the original defaults.

8. Close the window.

9. Run the utility, see “Running the ISIS Log Utility” on page 97.



Numerics
10 Gb network adapter

Client Manager preference setting 44
configuring as default connection 43
connection to ISIS engine 43
See also Chelsio 10 Gb network adapter
See also Myricom 10 Gb network adapter
UHRC client 44

A
Accessing

Client Manager Help 67
Adding remote host 56
Administration tool

See Management Console
Administrative tasks

clearing cached data 69
setting Client Manager display properties 57
using logs 70

Assigning mount points 64
Auto Connect (to System Directors) 52
Auto Mount (Workspaces) 61
Auto Reserve (bandwidth reservations) 69
Auto-connect (Client Manager) 30
Automatically Select (PathDiag File Access Protocol 

indicator) 74
Average rate (PathDiag tool)

calculation 84
read/write graph 75
test results 74

Avid
online support 10
training services 11

Avid Data Migration Utility
See Data Migration Utility

Avid ISIS Client Manager
See Client Manager

Avid ISIS Management Console
See Management Console

Avid PathDiag tool
See PathDiag tool

B
Bandwidth

Avid ISIS TransferManager 67
configuring reserve rate 68
limits 67
reserving (Client Manager) 67

Bandwidth reservations
Auto Reserve 69
Avid AirSpeed clients 67
Bandwidth dialog 68
configuring reserve rate 68
creating 68
described 67
releasing 68
unreserving (releasing) 68

Buttons
Client Manager 48
Data Migration Utility 92

C
Cached data (Client Manager)

clearing 69
Changing

ISIS passwords (Client Manager) 53
Clearing

cached data (Client Manager) 69
Client Manager logs 70

Client

Index



Index

102

10 Gb connections 17
configuring 37
dual 1 Gb connections 16
installers 27
licensing 34
network properties 37

Client logs 97, 99
Client Manager

accessing Help 67
Auto Connect 52
Auto Mount workspaces 61
auto-connect 30
Bandwidth dialog 68
bandwidth reservation 67
buttons 48
changing ISIS passwords 53
clearing cached data 69
clearing logs 70
configure 30
configuring mount points 64
connecting from Zone clients 51, 56
connecting to ISIS 51
connecting to Shared Storage network 52
described 46
documentation 11
fast user switching 26
filtering display 67
initial connection tests 61
installation 27
installation options 27
installing on Macintosh 33
licensing 34
logging 70
messages area 70
mounting Workspaces 61, 62
opening Management Console 54
Preferences dialog box 56
retrieving workspace details 66
saving logs 70
setting client type 59
setting display properties 57
software installation 26
software update 33
sorting display 66
umounting Workspaces 61
using 46
viewing logs 70

window 46
Windows Tray icon 53
Workspaces display 65

Client systems
10 Gb connections 17
dual 1 Gb connections 16
licensing 34
Linux Ethernet connections 36
Macintosh Ethernet connections 36
setting client type 59
Windows Ethernet network adapter slot locations 13

Client Type (Client Manager display properties) 58
Configure

Client Manager 30
Configuring

bandwidth reserve rate 68
clients 37
mount points 64

Connect button 30
Connecting

to Shared Storage network 52
Connection tests

See PathDiag tool
Control area (PathDiag tool) 74
Copy data between MediaNetwork and ISIS

See Data Migration Utility
Creating

bandwidth reservations 68
custom tests (PathDiag tool) 78
Network Connectivity test (PathDiag tool) 81
standard test (PathDiag tool) 76

Current Rate (PathDiag tool test results) 74
Custom test (PathDiag tool) 78

File Access Method 79
Max File Size 80
Reads vs Writes 80
Transfer Rate 80
Transfer Size 80
Use named common file for Reads 81

D
Data Migration Utility

buttons 92
connecting to Shared Storage network 90
described 86
icons 92



Index

103

loading software 88, 89
login 90
logs 96
Macintosh 87
network adapter slots 88
settings 95
start copy 93
stopping the copy 93
supported client operating systems 87
supported infrastructures 86
transfer queue 96
window described 90
Windows clients 88

Diagnostic tests (PathDiag tool) 76
Diagnostic tools

PathDiag tool 71
Disk image (Macintosh)

dismounting 33
mounting 33

Dismounting
disk images (Macintosh) 33

Display Bandwidth in Bits Per Second (Client Manager 
display properties) 58

Display properties
Client Type 58
Display Bandwidth in Bits Per Second 58
Enable Bandwidth Columns 58
Enable Bandwidth Dialog 68
Measure Free Space In 58
Start Client Manager Hidden 58
Use UNC (Letterless) Drive Mappings 58

Documentation
client software 11

Dongles 34
Drive letter mapping

See mount points
Drivers

Intel Pro/1000 network adapter 13
Dual 1 Gb connections 16
Duration (Minutes) (PathDiag tool standard test) 77

E
Enable Bandwidth Columns (Client Manager display 

properties) 58
Enable Bandwidth Dialog (Client Manager display 

properties) 68

Enable domain network 58
Enabling

Auto Reserve (bandwidth reservations) 69
Bandwidth dialog 68

Errors (PathDiag tool test results) 74
Ethernet

client software 37
Ethernet adapter

See also Intel Pro/1000 network adapter
Ethernet network adapter

supported types 12

F
Fast user switching 26
File Access Method (PathDiag tool standard test) 79
Filtering Workspaces list (Client Manager) 67
Firewall settings 58

Linux 36
Macintosh 36
Windows Vista (network profiles) 34
Windows XP 36

Flash software 27

H
Help (Client Manager

accessing 67
Host 56

I
I/Os (PathDiag tool test results) 74
Icons

Client Manager 48
Client Manager connection status 53
Data Migration Utility 92

Installation
Client Manager 26
Data Migration Utility 88, 89
Intel Pro/1000 drivers 13
options 27

Intel Pro/1000 network adapter
description 12
driver installation 13
slot locations 13
transmit/receive descriptors setting 14



Index

104

Internet protocol
Linux properties 41
Macintosh properties 40
Windows 7 properties 37
Windows 8 properties 37
Windows XP properties 39

Interpreting PathDiag tool test results 84
ISIS Administration tool

See Management Console
ISIS Client Manager

See Client Manager
ISIS Log Utility 97, 97
ISIS Management Console

See Management Console

L
Letterless (UNC) drive mapping

See mount points
Licensing (client) 34
Linux

Client Manager software update 33
client network properties 37
clients 41
firewall settings 36
IP address 41

Logging
Client Manager 70
Data Migration 96
PathDiag tool 77

Login
Data Migration Utility 90

Logs
Client Manager 70
PathDiag tool 77

Logs, client utility 97
Loop (PathDiag tool standard test) 77

M
Macintosh

Client Manager software update 33
client network properties 37
clients 27, 40
Data Migration Utility client requirements 87
dismounting disk image 33
dual 1 Gb connections 16

firewall settings 36
IP address 40
mounting disk image 33

Management Console
opening (from Client Manager) 54

Max File Size (PathDiag tool standard test) 80
Measure Free Space In (Client Manager display 

properties) 58
Measurement strategy (PathDiag tool test results) 85
Messages area

Client Manager 70
PathDiag tool 74

Microsoft Windows
See also Windows 7
See also Windows Vista
See also Windows XP
Auto Connect (Client Manager option) 52
Client Manager Tray icon 53

Mount points
as drive letters 64
as UNC paths 64
configuring 64

Mounting
disk images (Macintosh) 33
Workspaces 52
Workspaces (Auto Mount) 61

Myricom 10 Gb network adapter
driver 17
Macintosh installation 22
Macintosh setting 22
Windows installation 17
Windows settings 18

N
Network

properties 37
Network adapter slots

Data Migration Utility 88
Network and Sharing Center (Windows Vista) 34
Network Connectivity test

Ping Data Buffer Size 82
results table 82

Network Connectivity test (PathDiag tool) 81
Network profiles (Windows Vista) 34



Index

105

O
Online support 10
Opening

Management Console (from Client Manager) 54

P
Passwords

ISIS, changing (Client Manager) 53
PathDiag tool

Automatically Select (File Access Protocol 
indicator) 74

average rate calculation 84
Average Read or Average Write (Test Results graph) 

75
control area 74
custom tests 78
diagnostic tests 76
File Access Protocol indicator 74
I/O Operation indicator 75
interface 72
interpreting results 84
logging test results 77
measurement strategy 85
messages area 74
Network Connectivity test 81
Peak Read or Peak Write MS/100 (Test Results 

graph) 75
performance graph 84
Recent Read or Recent Write (Test Results graph) 75
results area 74
Self-Test (File Access Protocol indicator) 75
settings area 73, 76
standard test 76
standard test presets 77
starting 71
starting tests 83
stopping tests 83
test result interpretation 85
test results 74
Test Results graph 75
Win32 File API (File Access Protocol indicator) 75

Peak Read or Peak Write (PathDiag tool Test Results 
graph) 75

Performance graph (PathDiag tool test results) 84
Ping Data Buffer Size (Network Connectivity test) 82

Preferences (Client Manager) 56

R
Reads vs Writes (PathDiag tool standard test) 80
Receive descriptors (Ethernet network adapter setting) 

14
Recent Read or Write (PathDiag tool, results graph) 75
Releasing (unreserving) bandwidth reservations 68
Releasing bandwidth reservations 68
Remote Host 56
Reserving bandwidth 67
Results area (PathDiag tool) 74
Results table

Network Connectivity test 82

S
Saving

Client Manager logs 70
Data Migration Utility logs 96

Security
Linux firewall settings 36
Macintosh firewall settings 36
Windows Vista network profiles 34
Windows XP firewall settings 36

Self-Test (PathDiag File Access Protocol indicator) 75
Setting

Client Manager display properties 57
client type (Client Manager) 59
Data Migration Utility 95

Settings area (PathDiag tool) 73, 76
Slot locations

Intel Pro/1000 network adapter 13
Software

Data Migration Utility 88, 89
Flash 27

Sorting Workspaces list (Client Manager) 66
Standard test (PathDiag tool)

Duration 77
Loop 77
Path to Test 77
Test Name 77

Start Client Manager Hidden (Client Manager display 
properties) 58

Starting Data Migration Utility 93
Starting PathDiag tool tests 83



Index

106

Stopping Data Migration Utility copies 93
Stopping PathDiag tool tests 83
Subnet mask 37

T
TCP/IP 38
Test Name (PathDiag tool standard test) 77
Test results (PathDiag tool)

Average Rate (MB/s) 74
Current Rate (MB/s) 74
Errors 74
I/Os 74
interpretation 85

Test Results graph (PathDiag tool) 75
Testing network connection 61
Training services 11
Transfer Queue (Data Migration Utility) 96
Transfer Rate (PathDiag tool standard test) 80
Transfer Size (PathDiag tool standard test) 80
Transmit descriptors (Ethernet network adapter setting) 

14
Troubleshooting 10

U
UHRC Client

10 Gb network adapter 44
UNC (Universal Naming Convention) paths

letterless drive mappings (Client Manager display 
properties) 58

See also mount points
Unmounting

Workspaces 61
Unreserving (releasing) bandwidth reservations 68
Use named common file for Reads (PathDiag tool 

standard test) 81
User interface

described 46
window 46

Using
Client Manager 46
Data Migration Utility 86
UNC (Letterless) Drive Mappings (Client Manager 

display properties) 58
Utility

Data Migration 86

ISIS logs 97

V
Viewing

Client Manager logs 70
Data Migration logs 96

W
Win32 File API (PathDiag File Access Protocol 

indicator) 75
Windows

Client Manager software update 33
client network properties 37
clients 27
dual 1 Gb connections 16
fast user switching 26
Firewall settings 58
requirements for Data Migration Utility 88
update 27

Windows 7 clients 37
Windows Vista

See also Microsoft Windows
clients 37
Network and Sharing Center 34
network profiles 34

Windows XP
See also Microsoft Windows
clients 39
firewall settings 36

Workspaces
Auto Mount 61
bandwidth reservations 67
drive mapping 64
mount points 64
mounting 52, 61
unmounting 61

Workspaces display (Client Manager) 65
filtering 67
retrieving details 66
sorting 66

Z
Zone clients 51, 56



Avid
75 Network Drive
Burlington, MA 01803-2756 USA

Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support

Product Information
For company and product information, 
visit us on the web at www.avid.com


	Title Page

	Contents
	Chapter 1 Avid ISIS Client Manager Setup and Installation 12
	Chapter 2 Using Avid ISIS Client Manager 46
	Chapter 3 Avid PathDiag Tool 71
	Chapter 4 Data Migration Utility 86
	Chapter 5 ISIS Log Utility 97

	Using This Guide
	Who Should Use This Guide
	Symbols and Conventions
	If You Need Help
	Accessing the Online Documentation
	Avid Training Services

	Avid ISIS Client Manager Setup and Installation
	Intel Pro/1000 Network Adapter and Driver Installation
	Intel Pro/1000 Slot Locations
	HP Z820 Integrated Network Port Not Supported
	HP Z400 and HP Z800 Integrated Network Port Not Supported
	Loading or Updating the Intel Pro Driver on Windows Clients
	Intel Pro Driver Configuration Settings

	Dual Port Network Connections
	Myricom 10-Gb Network Adapter and Driver
	Installing the Myricom Network Adapter on Windows Clients
	Myricom Network Adapter Setting on Windows Clients
	Installing the Myricom Network Adapter on Macintosh Clients
	Myricom Network Adapter Setting on Macintosh Clients
	Updating the Myricom Driver on Macintosh Clients

	Client Software Installation
	Fast User Switching Not Supported
	Flash Player Software
	Loading Client Software
	ISIS Client Software Installation
	Configuring Client Software
	Macintosh Mountain Lion Operating System
	10 Gb Myricom Board Driver Macintosh v10.8.x Clients

	Updating Client Manager Software
	Client Licensing

	Configuring Network Profiles and Firewalls
	Configuring Windows 8, Windows 7, and Windows Vista Network Profiles
	Configuring the Windows XP Firewall
	Macintosh Support and Firewall
	Linux Firewall

	Configuring the Client Network Properties
	Windows 8, Windows 7, and Windows Vista Client Network Properties
	Windows XP Client Network Properties
	Macintosh Client Network Properties
	Linux Client Network Properties
	10 Gb Network Connections
	Configure 10 Gb Client Connection
	10-Gb Client Resolution Settings


	Using Avid ISIS Client Manager
	Client Manager Window
	Client Manager Buttons
	ISIS Shared Storage Network Connection
	Connecting to the ISIS Shared Storage Network
	Client Manager Tray Icon (Windows and Linux)
	Changing Your Password
	Opening the ISIS Management Console from the Client Manager

	Avid ISIS Client and Zone Descriptions
	Adding a Remote Host
	Setting the Client Manager Display Properties
	Setting Client Types
	Network Interface Setting

	ISIS Connection Tests
	Mounting and Unmounting Workspaces
	Configuring Workspace Mount Points

	Workspace Display
	Retrieving Workspace Details
	Sorting the Display
	Filtering the Display
	Accessing the Help

	Bandwidth Reservations
	Enabling Bandwidth Reservations
	Creating or Releasing Bandwidth Reservations

	Administrative Tasks
	Clearing Cached Data
	Using Logs and Messages


	Avid PathDiag Tool
	Starting Avid PathDiag Tool
	PathDiag Tool Interface
	Diagnostic Tests
	Setting Up a Standard Test
	Setting Up a Custom Test
	Setting Up a Network Connectivity Test

	Starting and Stopping the Test
	Test Results

	Data Migration Utility
	Data Migration Between Avid Storage Networks
	Operating Systems Qualified for Data Migration
	Macintosh Client Requirements
	Windows Client Requirements
	Windows Client Systems Qualified for Data Migration

	Data Migration Utility Installation
	Logging Into the Data Migration Utility
	Data Migration Window
	Data Migration Buttons
	Running the Data Migration Utility
	Transfer Preferences
	Transfer Queue and Logs

	ISIS Log Utility
	Running the ISIS Log Utility
	Changing Settings
	Numerics
	A
	B
	C
	D
	E
	F
	H
	I
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	Z


	Index

